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The DXM1200-X2 Wireless Controller is an industrial controller that uses wired and wireless 
networks to facilitate Industrial Internet of Things (IIoT) applications. As a communications 
gateway, this controller consolidates, processes, and distributes data using industrial or web 
service protocols by interfacing with local serial ports and local ISM radio devices.

High-Performance Wireless Communication—Uses Sure Cross® DX80 Wireless 
Gateway or MultiHop radio with 900 MHz or 2.4 GHz ISM bands available for long-range 
communication
Flexible and Customizable—Uses internal logic controller with action rules and 
ScriptBasic programming capable of developing simple or complex solutions to process, 
log, and control data to/from multiple wireless sensor radios and wired sensor devices
Easy Installation in all Environments—IP67 housing makes installation in any location 
simpler by eliminating the need for a control cabinet
Improved Speed and Memory—Internal processor provides 2850 32-bit integer registers, 
2000 floating-point registers, and 1050 non-volatile 32-bit integer registers; expanded 
ScriptBasic programming capability for faster script processing and ability to build more 
complex solutions with scripts
External Communications—Optional cellular modem with an external antenna for Internet connectivity
Industry Compatibility—Configurable controller works with a wide range of Modbus devices; quickly deploy Modbus 
server device data to EtherNet/IP™, Modbus® TCP, or PROFINET® networks

Four independent Modbus client ports increase simplicity and decrease deployment time for co-located assets
Up to four Modbus server devices can be used without needing to manually assign a server address to the 
connected devices

Cloud Connectivity—Visualize data and set alarms by sending data from the controller to BannerCDS.com or third-
party Internet sites
Customizable Alerts—Secure email and SMS (text) alerts when using Banner Cloud Data Services (CDS)
Data logged to an embedded flash memory chip
Interactive programmable user interface with LCD and LED indicators
Industry-standard RS-485, Ethernet, and USB communication ports

FeaturesChapter 1 
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Models

X2 =

Radio Configuration

X2
Base

DXM1200 R1

Blank = None
R1 = 900 MHz PE5 Performance Radio (North America)
R2 = 900 MHz HE5 MultiHop Data Radio (North America)
R3 = 2.4 GHz PE5 Performance Radio (Worldwide)
R4 = 2.4 GHz HE5 MultiHop Data Radio (Worldwide)

Base
–

Blank = Low profile housing

One 5-pin M12 power and RS-485 connector
External ISM and cellular antennas

Custom products are available and are designated with a 6-digit number
following the standard model number, such as DXM1200-X2R1-123456.
Not all model configurations are available. For more information 
about ordering a product customized for your specific needs, 
contact Banner Engineering.

Custom products are available and are designated with a 6-digit number following the standard model number, such as 
DXM1200-X2R1-123456. For more information about ordering a product customized for your specific needs, contact Banner 
Engineering Corp.

Cellular Communications—Controllers accept Banner LTE-M (CATM1) modems only. Cellular modems are ordered 
separately as accessories under the following part numbers:

LTE CAT-M1 AT&T (North America only):SXI-CATM1ATT-001
LTE CAT-M1 Verizon (United States only): SXI-CATM1VZW-001
LTE CAT-M1/NB-IoT Multi-Carrier (Europe only): SXI-CATM1WW-001

For more information, refer to the technical note Activating a Cellular Modem (p/n 205026).

Overview
Banner's DXM Logic Controller consolidates data from multiple sources using serial Modbus and local wireless networks to 
provide data processing as well as accessibility for host systems as a platform for the Industrial Internet of Things (IIoT).

The DXM1200-X2 contains four individual Modbus clients and one wireless gateway allowing for concurrent communication 
with up to five independent networks. Data is collected into the internal logic controller to facilitate edge processing, protocol 
conversion to industrial Ethernet, and pushing information to Web servers.

Inputs and Outputs Connectivity Logic Controller User Interface

N/A Cellular Action rules LCD screen

Sure Cross® radios Programming language LED indicators

Ethernet Scheduler RGB indicator

Embedded flash memory chip Push to the cloud

RS-485 Client Data logging

Modbus registers for internal local registers (Modbus ID 199) 

Local Registers  Type  Description 

1–845  32-bit integer  Local data registers 

846–849  32-bit integer  Reset, Constant, Timer 

851–900  32-bit non-volatile integer  Data flash, non-volatile 

Continued on page 7

http://info.bannerengineering.com/cs/groups/public/documents/literature/205026.pdf
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Continued from page 6

Local Registers  Type  Description 

901–1000    Reserved for internal use 

1001–5000  Floating point  Floating point registers, local data registers 

5001–7000  32-bit integer  Local data registers 

7001–8000  32-bit non-volatile integer  Data flash, non-volatile 

> 10000    Read-only virtual registers, system-level data 

Connections include:

Connectivity—The DXM1200-X2. The cellular modem option eliminates the 
need for IT infrastructures to connect remote equipment for sensing and control 
to IIoT cloud services.

The integrated Sure Cross® wireless radio enables Modbus connectivity to 
remote sensors, indicators, and control equipment.

Connect directly to any PLC and/or SCADA system for easy integration into 
existing control or monitoring systems.

Banner Industrial Wireless radios have two types of networks that can be used for creating applications and solving 
problems.
Wired Connectivity

Ethernet: Modbus/TCP (client/server) or Ethernet/IP
Field Bus: Modbus RS-485 Client

Wireless Connectivity
Sure Cross Wireless Radio: DX80 900 MHz, DX80 2.4 GHz, 
MultiHop 900 MHz, or MultiHop 2.4 GHz
Cellular modem: LTE-M (United States) or LTE-M/NB-IoT 
(outside the United States)

Wireless Radio Networks
Performance Wireless Radio Network

Star topology (point-to-point between Gateway and Node 
radios)
Battery-powered Node applications are more efficient in a star 
topology
Six inputs and six outputs maximum per radio

MultiHop Wireless Radio Network
Tree topology between one client radio and many repeater 
and/or server radios
Repeater radios add unlimited radio network range
Full Modbus sensor register data collection and typical local I/
O like discrete, analog, etc.

Logic Controller—Program the DXM1200-X2's logic controller using action rules and/or ScriptBasic language, which can 
execute concurrently. The control functions allow freedom when creating custom sensing and control sequences. The logic 
controller supports the Modbus protocol standards for data management, ensuring seamless integration with existing 
automation systems. File and LCD password protection is an option.
Register Mapping

Cyclical Read rules from wireless devices or local wired 
Modbus devices that include optional scaling, error conditions, 
and the ability to activate a read rule
Cyclical or change of state write rules to the wireless devices 
or the local wired Modbus devices with scaling
Modbus TCP Client read or write rules for external devices on 
the network

Action Rules
Thresholds (IF/THEN/ELSE) with timers, minimum on/off time, 
and logging options
Math/Logic Rules (arithmetic and bitwise operators)
Control Logic (logical operators and SR/T/D/JK flip flops)
Trending (multiple averaging filters)
Tracking (counts, on/off times)
Push data on conditions

One 4-pin M12 male connection that provides common power and 
ground to all M12 Modbus ports

1. 

One 4-pin 100 Mbps Ethernet female port that uses an D-code M12 
female Ethernet connection (Modbus TCP, EtherNet/IP, PROFINET, and 
Configuration/discovery port)

2. 

Cellular antenna connection for 4G LTE-M network connectivity (cellular 
modem and antenna sold separately)

3. 

Four 5-pin M12 female Modbus client connections (2-wire RS-485 
physical transceiver with power/ground at each connector)

4. 

ISM radio antenna connection for 900 MHz or 2.4 GHz frequency5. 
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Scheduler
Time/calendar-based events
Holiday skips
One-time events
Dynamic scheduler updating
Astronomical clock

Optional Text Programming Language
ScriptBasic to create variables, arrays, functions, loops, IF/
THEN/ELSE, logical and arithmetic operators, API commands, 
register access, string functions and operators, time 
commands

Data Logging
Cyclic data/event logging

User Interface— A simple user interface with an LCD and four LED indicators.
User programmable LCD

Bind Sure Cross radios
Conduct a site survey to evaluate the radio signal integrity of 
radios within the network
View register and output information
View system status and configuration

API Interface
Host Initiated control
Web service integration

User-Defined LED indicators
Indicates the status of the DXM1200-X2, processes, or 
equipment

User-Defined RGB indicator
Indicates the status of processes and alarm states

DXM Hardware Configuration Overview
The DXM1200-X2 Wireless Controller can have multiple configurations. The DXM1200-X2 will have a model number label on 
the housing. Use the model number and model table above to identify which boards are included in the controller.

When opening the DXM1200-X2, follow proper ESD grounding procedures.

IMPORTANT:
Electrostatic discharge (ESD) sensitive device
ESD can damage the device. Damage from inappropriate handling is not covered by warranty.
Use proper handling procedures to prevent ESD damage. Proper handling procedures include 
leaving devices in their anti-static packaging until ready for use; wearing anti-static wrist straps; 
and assembling units on a grounded, static-dissipative surface.

The top housing contains the LCD display board. The display board is connected to the base board using a ribbon cable with 
a 20-pin connector.
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DXM1200-X2 base board

*SIM card is located on the underside of installed modem

Cell Modem

Antenna Cable

SIM card*
location Micro USB

ISM
Radio
Board

Cellular Antenna Placement

Automation Protocols
The DXM1200-X2 supports the following automation protocols.

Modbus® RTU
The DXM1200-X2 manages separate physical ports running 
the Modbus RTU protocol. The DXM1200-X2 is the Modbus 
client when operating the Modbus client RTU port. The 
DXM1200-X2 uses the client Modbus RTU bus to 
communicate with locally connected Modbus devices or uses 
the Banner wireless radio to communicate with remote 
Modbus devices.

Modbus TCP/IP
A host system acting as a Modbus client can access the 
DXM1200-X2 using the Modbus TCP/IP protocol over 
Ethernet. Standard Modbus port 502 is used by the 
DXM1200-X2 for all Modbus TCP/IP requests.
All internal registers are available to the host system 
concurrently with Modbus RTU.
By default, Modbus TCP/IP client is active. If you are using the 
DXM as a Modbus TCP client, configure the DXM1200-X2
using Modbus TCP rules in the DXM Configuration Software.

EtherNet/IP™
The Ethernet port is actively running EtherNet/IP. From the 
factory, the DXM1200-X2 is configured to read and write 
registers on DX80 wireless devices 1 through 16. Custom 
individual local register configurations can be set with the 
Protocol Conversion field in the DXM Configuration Software.
By default, EtherNet/IP is active.
EtherNet/IP registers are limited to 228 registers set as E/IP 
Originator to DXM and 228 registers set as DXM to Originator.

PROFINET® (DXM1200-X2 only)
By default, PROFINET is disabled on the DXM1200-X2.
To configure the DXM1200-X2 for PROFINET 
communications, PROFINET must be enabled using the DXM 
Configuration Software. The DXM1200-X2 uses fixed Slot 
sizes and locations in the Local Registers for the Input and 
Output values. Module sizes supported are 64, 128, 256, and 
512 bytes which range from 32 to up to 256 Local Registers in 
the DXM1200-X2.

Modbus® is a registered trademark of Schneider Electric USA, Inc. PROFINET® is a registered trademark of PROFIBUS 
Nutzerorganisation e.V. EtherNet/IP™ is a trademark of ODVA, Inc. All other trademarks and registered trademarks cited are 
the property of their respective owners. 

Modbus Overview
The DXM1200-X2 uses internal 32-bit registers to store information. The processor's internal Local Registers serve as the 
main global pool of registers and are used as the common data exchange mechanism. External Modbus device registers can 
be read into the Local Registers or written from the local data registers.

The DXM1200-X2, as a Modbus client device, exchanges data using the Local Registers. Modbus over Ethernet (Modbus/
TCP) uses the Local Registers as the accessible register data.
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Using Action, Read/Write, and Threshold Rules allows you to manipulate the processor's Local Registers. The ScriptBasic 
programming capabilities extends the use of Local Registers with variables to create a flexible programming solution for more 
complex applications.

The processor's Local Registers are divided into three different types: integer, floating point, and non-volatile. When using 
Local Registers internally, the user can store 32-bit numbers. Using Local Registers with external Modbus devices follows the 
Modbus standard of a 16-bit holding register. Local Registers are accessible as Modbus ID 199.

Accessing the I/O Base and the LCD follows the same communication as an external Modbus device. Each device has an ID 
number to uniquely identify itself. The LCD is Modbus ID 201.

DXM1200-X2 Modbus overview

Ethernet

RS-485 (client)

Internal
Micro USB

Processor/Outputs (Base Board)
Local Registers
(Modbus ID 199)

Processor Controller

ISM Radio (Modbus ID 1)

User Display (Modbus ID 201)

Local Registers
Integer

Local Registers
Float

Local Registers
Non-Volatile

Cellular Modem

Modbus Data Traffic
Control

Gateway or MultiHop

LCD / LED

DXM1200-X2 Modbus Registers
The DXM1200-X2 Wireless Controller may have up to three internal Modbus server devices:

DXM1200-X2 internal Modbus IDs (factory default)

Modbus ID Device

1 DX80 Performance Gateway or MultiHop ISM Radio—MultiHop wireless devices connected to the internal MultiHop radio 
should be assigned Modbus IDs starting at 11.

199 Local Registers—Internal storage registers of the DXM1200-X2

201 LCD, LED, and RBG Indicator - The user has access to the LCD, LED Indicators, and RGB Indicator on the DXM1200-X2.

All Modbus registers are defined as 16-bit Modbus Holding Registers. When connecting external Modbus server devices, 
only use Modbus IDs 2 through 198. The Modbus IDs for the local registers, LCD, and ISM radio are fixed.

Modbus registers for the LCD board (Modbus ID 201) 

Modbus Register  LED  Color  State 

1102 : bit 0 LED 1  Red 

1 = On
 0 = Off 

1103 : bit 0 LED 2  Green 

1104 : bit 0 LED 3  Blue 

1105: bit 0 LED 4  Amber 

Continued on page 11
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Continued from page 10

Modbus Register  LED  Color  State 

1106: bit 0 Backlight   

Modbus Registers for the ISM Radio (Modbus ID 1)—See "Modbus Registers for the MultiHop Radio Board Module" on page 
23 and "Modbus Registers for the Performance Gateway Radio Module" on page 24.

Specifications
Radio Specifications for Performance and MultiHop (500 mW)
Radio Transmit Power (900 MHz, 500 mW radios)

Conducted: 27 dBm (500 mW)
EIRP with the supplied antenna: < 36 dBm

Radio Transmit Power (2.4 GHz radios)
Conducted: < 18 dBm (65 mW)
EIRP with the supplied antenna: < 20 dBm (100 mW)

Radio Range
A 2 dB antenna ships with this device.
Transmit power and range are subject to many factors, 
including antenna gain, installation methods, characteristics of 
the application, and environmental conditions.
Please refer to the following documents for installation 
instructions and high-gain antenna options.

Installing Your Sure Cross® Radios (151514) 
Conducting a Site Survey (133602)
Sure Cross® Antenna Basics (132113)

Antenna Minimum Separation Distance
900 MHz radios transmitting at ≥ 500 mW: 4.57 m (15 ft) with 
the supplied antenna
2.4 GHz radios transmitting at 65 mW: 0.3 m (1 ft) with the 
supplied antenna

Antenna Connection
Ext. Reverse Polarity SMA, 50 Ohms
Max Tightening Torque: 0.45 N·m (4 lbf·in)

Spread Spectrum Technology
FHSS (Frequency Hopping Spread Spectrum)

Link Timeout (Performance)
Gateway: Configurable via User Configuration Software 
Node: Defined by Gateway 

Radio Packet Size (MultiHop)
900 MHz: 175 bytes (85 Modbus registers)
2.4 GHz: 75 bytes (37 Modbus registers)

900 MHz Compliance (SX7023EXT Radio Module)
Radio module is indicated by the product label marking
Contains FCC ID: UE3SX7023EXT
Contains IC: 7044A-SX7023EXT

2.4 GHz Compliance (SX243 Radio Module)
Radio module is indicated by the product label marking
Contains FCC ID: UE3SX243
Radio Equipment Directive (RED) 2014/53/EU
Contains IC: 7044A-SX243

RS-485 Communication Specifications
Communication Hardware (MultiHop RS-485)

Interface: 2-wire half-duplex RS-485
Baud rates: 9.6k, 19.2k (default), or 38.4k via DIP switches; 
1200 and 2400 via the MultiHop Configuration Software
Data format: 8 data bits, no parity, 1 stop bit

DXM1200-X2 Specifications
Supply Voltage

12 to 30 V DC (use only with a suitable Class 2 power supply 
(UL) or a Limited Power Source (LPS) (CE) power supply)

Power Consumption
60 mA average at 24 V

Communication Protocols
Modbus® RTU, Modbus/TCP, Ethernet/IP™, and 
PROFINET®
EtherNet/IP™ is a trademark of ODVA, Inc. Modbus® is a 
registered trademark of Schneider Electric USA, Inc. 
PROFINET® is a registered trademark of PROFIBUS 
Nutzerorganisation e.V.

Connection
One 4-pin M12 male quick disconnect connector to supply 
power to the DXM
Four 5-pin M12 female quick disconnect connectors for 
RS-485 connections
One 4-pin D-Code industrial Ethernet female connector

Construction
Polycarbonate

Security Protocols
TLS, SSL, HTTPS

Logging
8 GB maximum; embedded flash memory chip

Certifications

 03737-22-04042

https://info.bannerengineering.com/cs/groups/public/documents/literature/151514.pdf
https://info.bannerengineering.com/cs/groups/public/documents/literature/133602.pdf
https://info.bannerengineering.com/cs/groups/public/documents/literature/132113.pdf
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Environmental Specifications (DXM1200)
Operating Conditions(1)

–20 °C to +60 °C (–4 °F to +140 °F)
95% maximum relative humidity (non-condensing)
Radiated Immunity: 3 V/m (EN 61000-4-3)

Environmental Rating
IP67

(1) Operating the devices at the maximum operating conditions for extended 
periods can shorten the life of the device.

Shock and Vibration
All models meet IEC 60068-2-6 and IEC 60068-2-27 testing 
criteria
Shock: 30G 11 ms duration, half sine wave per IEC 
60068-2-27
Vibration: 10 Hz to 55 Hz, 0.5 mm peak-to-peak amplitude per 
IEC 60068-2-6

DXM1200-X2 Dimensions
All measurements are listed in millimeters, unless noted otherwise. The measurements provided are subject to change.

DXM1200-X2 dimensions

148.1
[5.83]

25.0
[0.98]

170.5
[6.71]

50.0
[1.97]

9.0
[0.35]

30.6
[1.2]

90.8
[3.57]

20.0
[0.79]

21.0
[0.83]

2X

35.5
[1.4]

6X

140.8
[5.54]

2X  1/4 - 20
Threaded Insert

4-pin female M12 D-Code

50.8
[2.0]
55.9
[2.2]



04-Nov-25 page 13 of 76

DXM1200-X2 Controller Product Manual 

© Banner Engineering Corp. All rights reserved. 
www.bannerengineering.com

•
•

•
•
•

•
•
•

Chapter Contents
Device Setup ...................................................................................................................................................................................................... 13
Configuration Instructions................................................................................................................................................................................... 16

Device Setup
Apply Power to the DXM1200-X2 Controller
Use the following wiring diagrams to wire power and communication to the DXM1200-X2. Connecting power to the 
communication pins will cause permanent damage. Follow the steps to power your DXM using a wall plug.

Equipment used:
DXM1200-X2
PSW-24-1 DC power supply with multi-blade wall plug, 100–240 V AC 50/60 Hz input, 24 V DC 1 A output, UL Listed 
Class 2, 4-pin female M12 connector

Port 0 4-pin M12 male connector for power

Port 0 4-pin M12 male connector for power Pin Wire Color Description

1

4
3

2
1 Brown (bn) 12 V DC to 30 V DC

2 White (wh) RS485 / D1 / B / +

3 Blue (bu) DC common (GND)

4 Black (bk) RS485 / D0 / A / -

IMPORTANT:
Never operate a radio without connecting an antenna
Operating radios without an antenna connected will damage the radio circuitry.
To avoid damaging the radio circuitry, never apply power to a Sure Cross® Performance or Sure 
Cross® MultiHop radio without an antenna connected.

CAUTION:
Electrical damage
Wiring devices incorrectly causes electrical damage.
Do not apply more than 12 V to pins 2 or 4 for ports 1 through 4.

Ports 1-4 5-pin M12 female connector

Ports 1–4 5-pin M12 female connector Pin Wire Color Description

1

4 5
3

2 1 Brown (bn) 12 V DC to 30 V DC

2 White (wh) RS485 / D1 / B / +

3 Blue (bu) DC common (GND)

4 Black (bk) RS485 / D0 / A / -

Continued on page 14

Quick Start GuideChapter 2 

Connect the PSW-24-1 power supply into the DXM's 4-pin M12 male power port, aligning the keys in the connector 
and hand tightening.

1. 

Plug the PSW-24-1power supply into a power outlet using the appropriate regional wall adapter.2. 
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Continued from page 13

Ports 1–4 5-pin M12 female connector Pin Wire Color Description

5 Gray (gy) Not used/reserved

Ports 1-4 use the primary power from Port 0 to distribute power to downstream sensors connected to these ports. Power may 
also be injected on these ports to support downstream sensors on long cable runs.

4-pin D-code industrial Ethernet female connector

4-pin D-code industrial Ethernet female connector Pin Wire Color Description

1

4 3

2 1 Black (bk) +Tx

2 Red (rd) +Rx

3 Green (gn) –Tx

4 White (wh) –Rx

Binding and Conducting a Site Survey with the ISM Radio
Before the ISM radio can communicate, the ISM radio within the DXM must be bound to the other radios in the wireless 
network.

Use the DXM LCD menu to bind external radios to the internal ISM radio.

If you are having difficulty running binding or site surveys, it may be because of the speed of the XML configuration file or 
script running on the DXM. To resolve this issue, try one of the following options:

Disable the XML and script by setting DIP switch 4 on the processor board to ON and cycling the power to the DXM. 
After binding the devices, turn DIP switch 4 back OFF and cycle power again to return to normal operation of the XML 
and script.
Adjust the XML or script to slow down the RTU read or write rules.
Upload a blank XML, bind all devices, then upload the configured XML file.

Bind a DX80 Node to a DXM and Assign the Node Address
Binding Nodes to a Gateway ensures the Nodes only exchange data with the Gateway they are bound to. After a Gateway 
enters binding mode, the Gateway automatically generates and transmits a unique extended addressing (XADR), or binding, 
code to all Nodes within range that are also in binding mode. The extended addressing (binding) code defines the network, 
and all radios within a network must use the same code. 

Apply power to all the devices.
Separate radios by two meters when running the binding procedure. Put only one DXM Gateway into binding mode at 
a time to prevent binding to the wrong Gateway.

1. 

Enter binding mode on the DXM radio:2. 
Use the arrow keys to select the ISM Radio menu on the LCD and press ENTER.a. 
Highlight the Binding menu and press ENTER.b. 

◦

◦

Assign the Node address to the Node.
For Nodes without rotary dials: Use the DXM arrow keys to select the Node address to assign to the DX80 
Node about to enter binding mode. The DXM assigns this Node address to the next Node that enters binding 
mode. Only bind one Node at a time.
For Nodes with rotary dials: Use the Node's rotary dials to assign a valid decimal Node Address (between 01 
and 47). The left rotary dial represents the tens digit (0 through 4) and the right dial represents the ones digit 
(0 through 9) of the Node Address. You can leave the DXM "Bind to" address set to 1 because the Node's 
rotary dials will override that setting.

3. 

Start binding mode on the DXM radio by pressing ENTER on the DXM radio.4. 

◦
◦
◦

Enter binding mode on the DX80 Node.
For housed radios, triple-click button 2.
For board-level radios, triple-click the button.
For Nodes without buttons, refer to the Node's datasheet for instructions on entering binding mode.

5. 
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Bind a MultiHop Radio to a DXM and Assign the Device ID
Before beginning the binding procedure, apply power to all the devices. Separate radios by two (2) meters when running the 
binding procedure. Put only one DXM MultiHop client radio into binding mode at a time to prevent binding the server or 
repeater radios to the wrong client radio.

Binding MultiHop radios ensures all MultiHop radios within a network communicate only with other radios within the same 
network. The MultiHop client radio automatically generates a unique binding code when it enters binding mode. This code is 
transmitted to all radios within range that are also in binding mode. After a repeater/server radio is bound, the repeater/server 
radio accepts data only from the client radio to which it is bound. The binding code defines the network, and all radios within 
a network must use the same binding code. 

Conduct a Site Survey from the DXM
Conduct a Site Survey to verify the wireless communication between the radios within your wireless network.

Conduct the site survey when the Nodes and DXM Controller are at the proposed installation sites to determine each radio's 
signal strength with the DXM.

For a DX80 network, the Gateway controls the site survey and the results display on the LCD. Running a site survey on a 
DX80 network does not affect the throughput of the DX80 network. The DX80 Gateway-Node system can run a site survey 
analysis while the network is operational. For a MulitHop network, the client device passes the site survey request to the 
intended Modbus server device. The Site Survey runs and the results display on the LCD. Running a site survey on a 
MultiHop network stops all network traffic to that device.

The left and right LEDs flash alternately and the Node searches for a Gateway in binding mode. After the Node binds, 
the LEDs stay solid momentarily, then they flash together four times. The Node automatically exits binding mode and 
reboots.

Label the Node with the assigned address number for future reference.6. 

Press BACK on the DXM to exit binding mode for that specific Node address.
The Node LEDs continue to flash red until the DXM exits binding mode with that Node address.

7. 

Repeat these steps for as many DX80 Nodes as are needed for your network.8. 

When you are finished binding, press BACK on the DXM until you return to the main menu.9. 

Enter binding mode on the DXM radio:1. 
Use the arrow keys select the ISM Radio menu on the LCD and press ENTER.a. 
Highlight the Binding menu and press ENTER.b. 

◦

◦

Assign the device address to the repeater or server radios. Valid device IDs are 11 through 60.
For MultiHop radios without rotary dials: Use the DXM arrow keys to select the device ID to assign to the 
MultiHop radio about to enter binding mode. The DXM assigns this device ID to the next radio that enters 
binding mode. Only bind one server radio at a time.
For MultiHop radios with rotary dials: Use the MultiHop radio's rotary dials to assign a device ID . The left 
rotary dial represents the tens digit (1 through 6) and the right dial represents the ones digit (0 through 9) of 
the device ID. You can leave the DXM "Bind to" address set to 1 because the MultiHop's rotary dials will 
override that setting.

2. 

Start binding mode on the DXM radio by pressing ENTER on the DXM radio.3. 

◦
◦
◦

After entering binding mode on the DXM, put the MultiHop repeater or server radio into binding mode.
For housed radios, triple-click button 2.
For board-level radios, triple-click the button.
For radios without buttons, refer to the radio's datasheet for instructions on entering binding mode.

After binding is completed, the MultiHop radio automatically exits binding mode and begins operation.

4. 

Press BACK on the DXM to exit binding mode for that specific device address.
The MultiHop radio's LEDs continue to flash red until the DXM exits binding mode with that MultiHop radio.

5. 

Label the MultiHop radio with the assigned address number for future reference.6. 

Repeat these steps, changing the device address, for as many MultiHop radios as are needed for your network.7. 

When you are finished binding, press BACK on the DXM until you return to the main menu.
All radio devices begin to form the network after the client data radio exits binding mode.

8. 

On the DXM: Use the arrow buttons to select the ISM Radio menu and press ENTER.1. 
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If the Site Survey fails (100 missed packets), verify the radios are at least 10 feet from the DXM and/or rerun the binding 
procedure. If you find poor signal quality, common solutions include moving the DXM to a more central location relative to the 
Nodes or using higher-gain antennas on the DXM. Contact your local Banner Engineering representative for assistance.

Set a Static IP Address
Change the IP address of the DXM to connect to a local area network, Modbus TCP/IP host controller, or EtherNet/IP host 
controller.

There are two ways to set the IP address: using the DXM's LCD menu or using the configuration software to change the XML 
file. IP addresses entered into the LCD menu system override the IP addresses in the XML configuration files. To use the IP 
addresses set in the XML configuration file, clear the IP addresses from the menu system.

System Config menu options

System Config
to change the value

to acceptENTER

BACK to return to the previous menu

↑ ↓
Ethernet DHCP Update DHCP Mode

IP:
SN:
GW:
Reset

Update IP Address
Update SN
Update GW Address
Resets Ethernet parameters
to xml defaults.

After making changes to the
Ethernet settings, restart the DXM.

Use this same procedure to set the subnet mask (SN) and default gateway (GW) to match your network requirements. Your 
IT department can provide these settings if needed.

Configuration Instructions
DXM Configuration Software Overview
Configure the controller using the configuration software. Use this software to customize your configuration and to process 
data from the Controller.

Download the latest version of all configuration software from http://www.bannerengineering.com. For more information on 
using the DXM Configuration Software, refer to the instruction manual (p/n 209933).

Select the Site Survey menu and press ENTER.2. 

Use the Up or Down arrows to select the device ID number and press ENTER to run the site survey with that radio.
The site survey results display as green, yellow, red, and missed packets. Green indicates the highest signal strength, 
then yellow, and red. Missed packets were not received.

3. 

When you are finished running the Site Survey, press Back twice to return to the main menu and exit site survey 
mode.

4. 

On the DXM, use the arrows and move to the System Config menu. Press ENTER.1. 

Use the arrow keys to select the Ethernet menu. Press ENTER.2. 

Highlight the DHCP selection and press ENTER. Set DHCP to OFF.3. 

The system will request a restart, press ENTER to confirm.4. 

Follow steps 1 and 2 to reenter the Ethernet menu. Use the arrow keys to select IP. Press ENTER.
The IP address displays (for example, 192.168.0.1).

5. 

Use the up and down arrows to change the IP address. Press ENTER to move to the next octet.6. 

Press ENTER on the final octet to accept the changes.7. 

Cycle power to the DXM.
The changes are saved on the DXM and the new IP address will be used.

8. 

http://www.bannerengineering.com
http://info.bannerengineering.com/cs/groups/public/documents/literature/209933.pdf
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Overview of the DXM Configuration Software features

Internal Micro
USB

Ethernet

DXM Configuration Software

Local Registers

Register
View Utility

System
Settings

Register Mapping

Scheduler

Action Rules

ScriptBasic

XML Config File

The DXM Configuration Software configures the DXM1200-X2 by 
creating an XML file that is transferred to the DXM1200-X2 using 
an Ethernet connector or the internal micro USB connection. The 
DXM1200-X2 can also receive the XML configuration file from a 
Web server using a cellular or Ethernet connection, depending on 
your model.

This configuration file governs all aspects of the DXM1200-X2
operation.

The DXM Configuration Software allows the user to define 
parameters for the Controller and then saves the configuration in 
an XML file on the PC. After the configuration file is saved, upload 
the XML configuration file to the Controller for operation.

The wireless network devices are a separate configurable system. 
Use the DX80 User Configuration Software to configure the internal 
DX80 wireless Gateway and the attached wireless Nodes. Use the 
MultiHop Configuration Software if the internal radio is a MultiHop 
device.

All tools can be connected to the DXM1200-X2 using an Ethernet 
connection or the internal micro USB.

Configuring the DXM1200-X2 Controller
This section walks you through setting up the DXM Configuration Software and communicating with a connected DXM 
device. Version 4 of the DXM Configuration Software supports multiple DXM device models, each of which incorporates 
different features.

After a DXM model is connected to your computer, the software automatically detects the correct model and loads the 
appropriate screens. You may also manually select which model of DXM you are configuring if you intend to create a 
configuration file without first connecting a device. This ensures that the interface and the configuration file use the correct 
features.

Not all screens are available for all models. To change to another model of DXM, go to the Select Mode screen and use the 
drop-down list to select another model. If the active configuration is incompatible with the selected model, you will be 
prompted to either proceed and wipe out the active configuration or cancel the model change and preserve the configuration.

Connect the DXM1200 to the Software
Follow these steps to connect your DXM1200 to the software and download the existing configuration file.

On the computer, download the DXM Configuration Software v4 from the Banner Engineering website and install it.1. 

On the DXM: Apply power to the DXM.2. 

Connect the DXM Controller to the computer with an M12 to RJ-45 cable or skip if the DXM is connected to the same 
network as the computer.

3. 

On the computer: Launch the DXM Configuration Software.4. 

From the Connect to DXM menu, use the Select DXM Model drop-down list to select your controller model.5. 

http://info.bannerengineering.com/cs/groups/public/documents/software/b_4496867.exe
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Configuration Example: Reading Registers on a Modbus Server Device
The Local Registers are listed on the Local Registers › Local Registers in Use screen. The local registers are the main global 
pool of registers that are defined by the user to store data within the DXM1200-X2.

The bottom status bar displays the communications status, application status, and the DXM Configuration Software version.

In this short example, we will configure the DXM1200-X2 to read six registers on an external Modbus server device and save 
the data into the local registers.

The software only loads a file to the DXM. Internal parameter settings that are changed in the software but not saved to the 
file will not be sent to the device.

Define the Local Registers
Change the name and parameter settings for each Local Register under the Local Registers in Use screen. You may change 
them individually (Edit Register) or in groups (Modify Multiple Registers).

Modify Multiple Registers - Configuration Example

Create an RTU Read Rule
Follow these steps to create a new read rule.

This example screen shows a read rule created to read six registers (address 1 through 6), from Modbus ID 4. The results 
are stored in the Local Registers 1 through 6.

◦

◦

On the menu bar, go to Device › Connection Settings.
If you are connected to the same network as the DXM, select TCP/IP and enter the DXM IP address. Click 
Connect.
If you are using a USB cable, select Serial, then select the COM port that the USB cable is plugged into. Click 
Connect. If you are unsure which COM port and multiple appear, attempt to connect to each one of them until 
successful.

6. 

After the DXM is connected to the software, click Device › Get XML configuration from DXM to download the current 
XML file.

7. 

Name and save the file to the computer.8. 

Step 1: Define the Local Registers.1. 
Step 2: Create an RTU Read Rule.2. 
Step 3: Create an RTU Read Rule for the DXM1200-B2 or -X2 Controller.3. 
Step 3: Set the Time4. 
Step 4: Save and Upload the Configuration File5. 

Click on the Modify Multiple Registers section of the Local Registers in Use screen.
Use this screen to quickly modify multiple local registers at a time.

1. 

Select the range of registers to change.2. 

Select the fields to change in each local register.
In our example, registers one through six will be changed and the names will be GPS Reg followed by an auto-
incremented number. This example will also change the LCD permissions flag to Set, then Read to allow the values of 
the local registers to display on the LCD.

3. 

Click Modify Registers to apply your changes.4. 
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Read Rules - Configuration Example

Create an RTU Read Rule for the ISM Radio of a DXM1200-B2 or -X2
Follow these steps to create a new read rule to access data from devices connected to the radio of a DXM1200-B2 or 
DXM1200-X2.

This example creates a read rule to read six registers (1 through 6), from the radio (port 5) at Modbus ID 1. The results are 
stored in the Local Registers 1 through 6.

From the Register Mapping › RTU › RTU Read screen, click Add Read Rule.1. 

Click the arrow next to the name to display the parameters.2. 

Name your rule.3. 

Select the device ID.4. 

Select how many registers to read, and the beginning register.5. 

Define the register type, how often to read the register, and any other appropriate parameters.6. 

If necessary, select the error condition. For this example, if the read function fails after three attempts, the read rule 
writes 12345 to the DXM local registers. Notice the list of local register names this read rule is using.

7. 

Define the port settings to be compatible with the connected devices.1. 
Go to the Register Mapping › RTU › RTU Configuration screen.a. 
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◦

◦

Timeout controls how long the controller waits before determining a command has failed to send. Set the 
Timeout based on the specific application requirements. The minimum Timeout interval for Radio (Port 5) is 
62.5  ms.
Delay between messages defines the minimum wait time before sending another command. Set the delay 
based on the specific application requirements.

RTU Configuration screen

Go to the RTU configuration panel for Radio (Port 5).b. 
Modify the port settings as needed.c. 

From the Register Mapping › RTU › RTU Read screen, click Add Read Rule.2. 

Click the arrow next to the name to display the parameters.3. 

Name your rule.4. 

Select the port number to which the device is connected. For wireless devices, this is Radio (Port 5).5. 

Select the Modbus ID of the device. For wireless devices, this is Modbus ID 1.6. 

Select how many registers to read and select the beginning register.
Refer to the Modbus Holding Register table within the documentation for each server device.

7. 

Define the register type, how often to read the register, and any other appropriate parameters.8. 

If necessary, select the error condition. For this example, if the read function fails after three attempts, the read rule 
writes 12345 to the DXM local registers. Notice the list of local register names this read rule is using.

9. 
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Set the Time
Use the Settings › System screen to define the time zone and daylight saving option. The time zone and DST options are 
saved into the configuration file.

Settings > System > Device Time

Save and Upload the Configuration File
After making any changes to the configuration, you must save the configuration files to your computer, then upload it to the 
device.

Changes to the XML file are not automatically saved. Save your configuration file before exiting the software and before 
sending the XML file to the device to avoid losing data. If you select DXM › Send XML Configuration to DXM before saving 
the configuration file, the software will prompt you to choose between saving the file or continuing without saving the file.

Read Rules - Configuration Example

Go to the Settings › System screen.1. 

If you connect the DXM to a computer, click Sync PC Time with Device to set the time on the DXM to match the time 
of the computer.

2. 

Set your time zone and select whether or not your device observes daylight saving time (DST).3. 

Save the XML configuration file to your hard drive by going to the File › Save As menu.1. 

◦

◦
◦

Go to the DXM › Send XML Configuration to DXM menu.

Status indicator bar

If the Application Status indicator is red, close and restart the DXM Configuration Software, unplug and re-plug 
in the cable and reconnect the DXM to the software.
If the Application Status indicator is green, the file upload is complete.
If the Application Status indicator is gray and the green status bar is in motion, the file transfer is in progress.

After the file transfer is complete, the device reboots and begins running the new configuration.

2. 
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ISM radio board

DIP Switch
Bank 1

Button

LED

DIP Switch
Bank 2
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Antenna

2
3

4

2
3

4
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Plug the ISM radio into the I/O base board with the U.FL antenna connector closest to the SMA connectors. Typically, users 
will not need to adjust the DIP switch settings on the physical radio modules.

For the DXM models with a display, set the radio options using the LCD 
menu.

Button Operation
For DXM models without an LCD, use the button to bind the ISM radio. 
For models with an LCD, use the ISM menu to bind the radio.

LED Operation
The LED located on the ISM radio module indicates power and 
communications traffic. ISM board LED operations also display on the 
LED on the right side of the I/O base board.

Solid green DX80 ISM radio LED indicates power.
Flashing green MultiHop ISM radio LED indicates operation.
Red and green combined: Communications traffic and binding.

DIP Switches for the MultiHop Radio
MultiHop ISM radio models include R2, R4, or R5 in the model number.

DXMxxx-xxR2 - MultiHop 900 MHz
DXMxxx-xxR4 - MultiHop 2.4 GHz
DXMxxx-xxR5 - MultiHop 900 MHz, 100 mW
DXMxxx-xxR9 - MultiHop 900 MHz, (Australia)

Making changes to the baud or parity settings requires that you make the same settings to the Modbus Client 
Communications section within the DXM Configuration Software (Settings › General.

Disabling the serial port disables the ISM radio in the DXM1200-X2. Selecting Transparent mode causes radio 
communications to be slower and denies access to device I/O register data.

DIP switch settings

D1 Switches D2 Switches

Device Settings 1 2 3 4 1 2 3 4

Serial line baud rate 19200 OR User defined receiver 
slots OFF* OFF*

Serial line baud rate 38400 OR 32 receiver slots OFF ON

Serial line baud rate 9600 OR 128 receiver slots ON OFF

Serial line baud rate Custom OR 4 receiver slots ON ON

Parity: None OFF* OFF*

Parity: Even OFF ON

Parity: Odd ON OFF

Disable serial (low power mode) and enable the receiver 
slots select for switches 1-2 ON ON

Continued on page 23

ISM Radio Board (ID 1)Chapter 3 
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Continued from page 22

D1 Switches D2 Switches

Device Settings 1 2 3 4 1 2 3 4

Transmit power
900 MHz radios: 500 mW (27 dBm)
2.4 GHz radios: 65 mW (18 dBm) and 60 ms frame

OFF*

Transmit power
900 MHz radios: 250 mW (24 dBm)
2.4 GHz radios: 65 mW (18 dBm) and 40 ms frame

ON

Application mode: Modbus OFF*

Application mode: Transparent ON

MultiHop radio setting: Repeater OFF OFF

MultiHop radio setting: Client OFF ON

MultiHop radio setting: Server ON OFF

MultiHop radio setting: DXM LCD Menu Control ON* ON*

* Default configuration. The default settings for D2 DIP switches 3 and 4 are ON. This allows for forcing the device into client 
mode and DXM menu control for the radio power settings.

Application Mode
The MultiHop radio operates in either Modbus mode or transparent mode. Use the internal DIP switches to select the mode 
of operation. All MultiHop radios within a wireless network must be in the same mode.

Modbus mode uses the Modbus protocol for routing packets. In Modbus mode, a routing table is stored in each parent device 
to optimize the radio traffic. This allows for point-to-point communication in a multiple data radio network and 
acknowledgment/retry of radio packets. To access a radio's I/O, the radios must be running in Modbus mode.

In transparent application mode, all incoming packets are stored, then broadcast to all connected data radios. The data 
communication is packet-based and not specific to any protocol. The application layer is responsible for data integrity. For 
one-to-one data radios it is possible to enable broadcast acknowledgment of the data packets to provide better throughput. In 
transparent mode, there is no access to the radio's I/O.

Baud Rate and Parity
The baud rate (bits per second) is the data transmission rate between the device and whatever it is physically wired to. Set 
the parity to match the parity of the device you are wired to.

Disable Serial
Disable an unused local serial connection to reduce the power consumption of a data radio powered from the solar assembly 
or from batteries. All radio communications remain operational.

Transmit Power Levels/Frame Size
The 900 MHz data radios can be operated at 500 mW (27 dBm) or 250 mW (24 dBm). For most models, the default transmit 
power is 500 mW.

For 2.4 GHz radios, the transmit power is fixed at 65 mW (18 dBm) and DIP switch 5 is used to set the frame timing. The 
default position (OFF) sets the frame timing to 60 milliseconds. To increase throughput, set the frame timing to 40 
milliseconds. For battery-powered devices, increasing the throughput decreases battery life.

Modbus Registers for the MultiHop Radio Board Module
The DX80 MultiHop client radio is a tree-based architecture device that allows for repeater radios to extend the wireless 
network. Each device in a MultiHop network is a Modbus device with a unique Modbus ID.

Modbus registers in a MultiHop network are contained within each individual radio device. To obtain Modbus register data 
from a MultiHop device, configure the DXM1200-X2 to access each device across the wireless network as an individual 
Modbus server device.
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•
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•

DIP switch bank 1 and bank 2

DIP Switch
Bank 1

Button

LED

DIP Switch
Bank 2

11 ONON

Antenna

2
3

4

2
3

4

Example MultiHop Modbus registers with generic devices.

MulitHop Device Modbus ID Modbus Registers

DXM client radio 1 none

Server radio 11 Modbus register 1–16 are inputs, 501–516 are outputs

Repeater radio 12 Modbus register 1–16 are inputs, 501–516 are outputs

Server radio 15 Modbus register 1–16 are inputs, 501–516 are outputs

DIP Switch Settings for the Performance Gateway Radio 
Module
The 900 MHz radios have a high output option that will transmit at 500 mW 
(27 dBm). The low output option transmits at 250 mW (24 dBm). The 250 mW 
mode reduces the radio's range but improves the battery life in short-range 
applications. For 2.4 GHz models, this DIP switch is disabled. The transmit 
power for 2.4 GHz is fixed at about 65 mW EIRP (18 dBm). 

DX80 Performance Gateway ISM radio devices include R1, R3, or R8 in the 
model number.

DXMxxx-xxR1 - DX80 Performance 900MHz
DXMxxx-xxR3 - DX80 Performance 2.4GHz
DXMxxx-xxR8 - DX80 Performance 900MHz (Australia)

IMPORTANT: To adjust the transmit power on the Gateway 
radio, Banner recommends using the LCD menu (System 
Conf › ISM Radio › RF CNTRL).

DIP switch settings for bank 1

DIP Switch 1

OFF 500 mW (27 dBM) (default configuration; 900 MHz only)

ON 250 mW (24 dBm, 900 MHz models only), DX80 compatibility mode

Modbus Registers for the Performance Gateway Radio 
Module
The DX80 Performance Gateway is a star-based architecture device that contains all the Modbus registers for the wireless 
network within the Gateway. To access any input or output values within the entire wireless network, read the appropriate 
Modbus register from Gateway.

There are 16 Modbus registers allocated for each device in the wireless network. The first 16 registers (1–16) are allocated 
for the Gateway, the next 16 (17–32) are allocated for Node 1, the next 16 (33–48) are allocated for Node 2 and so forth. 
There are no inputs or outputs on the DXM embedded Gateway but the Modbus registers are still allocated for them.

Although only seven Nodes are listed in the table, the Modbus register numbering continues for as many Nodes as are in the 
network. For example, the register number for Node 10, I/O point 15 , is 175. Calculate the Modbus register number for each 
device using the equation:

Register Number = I/O# + (Node# × 16)
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Modbus holding registers

 I/O Point   Gateway   Node 1   Node 2   Node 3   Node 4   Node 5   Node 6   Node 7 

1  1  17  33  49  65  81  97  113 

2  2  18  34  50  66  82  98  114 

3  3  19  35  51  67  83  99  115 

4  4  20  36  52  68  84  100  116 

5  5  21  37  53  69  85  101  117 

6  6  22  38  54  70  86  102  118 

7  7  23  39  55  71  87  103  119 

8  8  24  40  56  72  88  104  120 

9  9  25  41  57  73  89  105  121 

10  10  26  42  58  74  90  106  122 

11  11  27  43  59  75  91  107  123 

12  12  28  44  60  76  92  108  124 

13  13  29  45  61  77  93  109  125 

14  14  30  46  62  78  94  110  126 

15  15  31  47  63  79  95  111  127 

16  16  32  48  64  80  96  112  128 

Access all wireless network registers by reading Modbus ID 1

DX80 Device Modbus ID Modbus Registers

DXM Gateway radio 1 Modbus registers 1–8 are inputs, 9–16 are outputs

Node 1 - Modbus registers 17–24 are inputs, 25–32 are outputs

Node 2 - Modbus registers 33–40 are inputs, 41–48 are outputs

Node 3 - Modbus registers 49–56 are inputs, 57–64 are outputs

Alternative Modbus Register Organization
The Sure Cross DX80 Alternative Modbus Register Organization registers are used for reordering data registers to allow host 
systems to efficiently access all inputs or outputs using a single Modbus command. The register groups include the input/
output registers, bit-packed registers, and analog registers. This feature is only available with the Performance models using 
version 3 or newer of the LCD firmware code.

Alternative Modbus register organization

Name Modbus Register Address (Decimal)

Inputs and Outputs, in order by device 2201 through 4784

Discrete Bit Packed (Status, Discrete Inputs, Discrete Outputs) 6601 through 6753

Analog Inputs (1–8) and Analog Outputs (1–8) 6801 through 9098

Input Registers and Outputs Registers
Modbus registers 2201 through 2584 are used to organize all inputs together.

In this format, users can sequentially read all input registers using one Modbus message. Modbus registers 4401 through 
4784 organize all outputs together to allow users to sequentially write to all output registers using one Modbus message.
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Input and output registers

Inputs (2201–2584) Outputs (4401–4784)

Modbus Register Address (Decimal) 16-bit Register Value Modbus Register Address (Decimal) 16-bit Register Value

2201–2208 Gateway Inputs 1 through 8 4401–4408 Gateway Outputs 1 through 8

2209–2216 Node 1 Inputs 1 through 8 4409–4416 Node 1 Outputs 1 through 8

2217–2224 Node 2 Inputs 1 through 8 4417–4424 Node 2 Outputs 1 through 8

... ... ... ...

2577–2584 Node 47 Inputs 1 through 8 4777–4784 Node 47 Outputs 1 through 8

Refer to your device's datasheet for a list of the active inputs and outputs. Not all inputs or outputs listed in this table may be 
active for your system.

Discrete Bit-Packed Registers
Discrete bit-packed registers include the discrete status registers, discrete inputs, and discrete outputs.

Bit packing involves using a single register, or range of contiguous registers, to represent I/O values.

When networks use similar Nodes to gather data using the same I/O registers for each Node, discrete data from multiple 
Nodes can be bit packed into a single register on the Gateway. The bit-packed data is arranged by I/O point starting at 
Modbus register 6601. For example, Discrete IN 1 for all the Nodes in the network is stored in three contiguous 16-bit 
registers.

The most efficient way to read (or write) discrete data from a Sure Cross® DX80 Gateway is by using these bit-packed 
registers because users can read or write registers for all devices using one Modbus message. The following registers 
contain discrete bit-packed I/O values for the Gateway and all Nodes. Values are stored first for the Gateway, then for each 
Node in order of Node address.

Discrete bit-packed register addresses and bit positions
Bit-Packed Device Status Registers

Bit Position
Register Address 15 14 13 12 11 10
6601 Node 15 Node 14 Node 13 Node 12 Node 11 Node 10 Node 9 Node 8 Node 7 Node 6 Node 5 Node 4 Node 3 Node 2 Node 1 Gateway
6602 Node 31 Node 30 Node 29 Node 28 Node 27 Node 26 Node 25 Node 24 Node 23 Node 22 Node 21 Node 20 Node 19 Node 18 Node 17 Node 16
6603 Node 47 Node 46 Node 45 Node 44 Node 43 Node 42 Node 41 Node 40 Node 39 Node 38 Node 37 Node 36 Node 35 Node 34 Node 33 Node 32

Bit-Packed Discrete Input 1

Register Address 15 14 13 12 11 10
6611 Node 15 Node 14 Node 13 Node 12 Node 11 Node 10 Node 9 Node 8 Node 7 Node 6 Node 5 Node 4 Node 3 Node 2 Node 1 Gateway
6612 Node 31 Node 30 Node 29 Node 28 Node 27 Node 26 Node 25 Node 24 Node 23 Node 22 Node 21 Node 20 Node 19 Node 18 Node 17 Node 16
6613 Node 47 Node 46 Node 45 Node 44 Node 43 Node 42 Node 41 Node 40 Node 39 Node 38 Node 37 Node 36 Node 35 Node 34 Node 33 Node 32

Bit-Packed Discrete Output 1

Bit Position
Register Address 15 14 13 12 11 10
6691 Node 15 Node 14 Node 13 Node 12 Node 11 Node 10 Node 9 Node 8 Node 7 Node 6 Node 5 Node 4 Node 3 Node 2 Node 1 Gateway
6692 Node 31 Node 30 Node 29 Node 28 Node 27 Node 26 Node 25 Node 24 Node 23 Node 22 Node 21 Node 20 Node 19 Node 18 Node 17 Node 16
6693 Node 47 Node 46 Node 45 Node 44 Node 43 Node 42 Node 41 Node 40 Node 39 Node 38 Node 37 Node 36 Node 35 Node 34 Node 33 Node 32

Bit Position

Discrete bit-packed registers for inputs and outputs

Inputs Outputs

Modbus Register Address 
(Decimal)

Description (Inputs) Modbus Register Address 
(Decimal)

Description (Outputs)

6601–6603 Status for all devices

6611–6613 Input 1 from all devices 6691–6693 Output 1 from all devices

6621–6623 Input 2 from all devices 6701–6703 Output 2 from all devices

Continued on page 27
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Continued from page 26

Inputs Outputs

Modbus Register Address 
(Decimal)

Description (Inputs) Modbus Register Address 
(Decimal)

Description (Outputs)

6631–6633 Input 3 from all devices 6711–6713 Output 3 from all devices

6641–6643 Input 4 from all devices 6721–6723 Output 4 from all devices

6651–6653 Input 5 from all devices 6731–6733 Output 5 from all devices

6661–6663 Input 6 from all devices 6741–6743 Output 6 from all devices

6671–6673 Input 7 from all devices 6751–6753 Output 7 from all devices

6681–6683 Input 8 from all devices

Status registers (6601–6603) contain a bit-packed representation defining the devices that are operational in the wireless 
system. Each bit indicates Node in Sync (1) or Node Not in Sync (0).

A one (1) written to the Discrete Status Register area indicates the device is active within the wireless system. A zero (0) 
indicates the device is not active within the wireless network.

Input registers from all devices use Modbus registers 6611 through 6683 to organize the least significant bit into a sequential 
array of registers. The first register contains the least significant bit from the input values for the Gateway through Node 15. 
The second register contains the input values for Node 16 through Node 31, and the third register contains the input values 
for Nodes 32 through 47.

For discrete inputs, only the least significant bit is used. For analog inputs, the least significant bit indicates if the analog 
value is above or below the selected threshold value (when using the threshold parameter configured in the User 
Configuration Software). For example, a least significant bit of one (1) indicates the analog value is above the selected 
threshold value. A least significant bit of zero (0) indicates the analog value is below the threshold value.

Output registers from all devices use Modbus registers 6691 through 6753 to organize the least significant bit into a 
sequential array of registers. Output 8 (I/O point 16) cannot be written using the discrete format.

Analog 16-Bit Registers (Registers 6801 through 9098)
The most efficient way to read (or write) analog data from a Gateway is by using these 16-bit analog registers. Most networks 
consist of similar Nodes reporting data using the same I/O registers for each Node. For this reason, the analog data is 
arranged by I/O point using Modbus registers 6801 through 9098.

For example, Input 1 for Gateway and all Nodes is stored in the first 48 contiguous blocks of 16-bit analog registers, 
beginning with register 6801.

In this format, users can read a 16-bit holding register for all devices or write to a register for all devices using one Modbus 
message. Using these registers is the most efficient way to read all status registers, read all analog inputs, or write all analog 
outputs.

The following registers contain analog I/O values for the Gateway and all Nodes. Values are stored first for the Gateway, then 
for each Node in order of Node address.

Analog input and output registers

Inputs Outputs

Modbus Register Address 
(Decimal)

Description (Inputs) Modbus Register Address 
(Decimal)

Description (Outputs)

6801 Input 1 for Gateway 8001 Output 1 for Gateway

6802 Input 1 for Node 1 8002 Output 1 for Node 1

6803 Input 1 for Node 2 8003 Output 1 for Node 2

... ... ... ...

6951 Input 2 for Gateway 8151 Output 2 for Gateway

6952 Input 2 for Node 1 8152 Output 2 for Node 1

6953 Input 2 for Node 2 8153 Output 2 for Node 2

Continued on page 28
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Continued from page 27

Inputs Outputs

Modbus Register Address 
(Decimal)

Description (Inputs) Modbus Register Address 
(Decimal)

Description (Outputs)

... ... ... ...

7101 Input 3 for Gateway 8301 Output 3 for Gateway

7102 Input 3 for Node 1 8302 Output 3 for Node 1

7103 Input 3 for Node 2 8303 Output 3 for Node 2

... ... ... ...

7851 Input 8 (Status Register) for Gateway 9051 Output 8 for Gateway

7852 Input 8 (Status Register) for Node 1 9052 Output 8 for Node 1

7853 Input 8 (Status Register) for Node 2 9053 Output 8 for Node 2

... ... ... ...

For example, 6801 contains the input 1 value for the Gateway, 6802 contains the input 1 value for Node 1, and 6848 contains 
the input 1 value for Node 47.
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DXM1200-X2 base board, cellular modem board, and ISM radio board

*SIM card is located on the underside of installed modem

Cell Modem

Antenna Cable

SIM card*
location Micro USB

ISM
Radio
Board

Cellular Antenna Placement

Button Operation
The button is used for special functions, as defined in the 
configuration or advanced configuration instructions.

LED Operation
LED1 flashes to indicate the processor board is running.
The LED starts flashing about 10 seconds after power is 
applied and a network connection is present. Without an 
ethernet network connection, the LED starts to flash after 
about 40 seconds.

Cellular Modem Connection
Install the cellular modem onto the board with the cellular 
modem's U.FL connector as shown. Only install/remove a 
cellular modem when the power to the device is disconnected.

DIP Switch Settings for the Base Board
After making changes to the DIP switch settings, cycle power to the device.

DIP switches for the base board

Settings
DIP Switches

1 2 3 4

Ethernet port enabled (default setting) OFF *

Ethernet port disabled ON

LCD enabled (default setting) OFF *

LCD disabled ON

Not used (default setting) OFF *

XML configuration file active (default) OFF *

XML configuration file bypassed ON

Bypass XML
Turn on to have the XML file ignored at boot time. This is 
useful for ignoring a corrupt or questionable XML 
configuration file. After the device is running, a new XML file 
can be loaded using the DXM configuration tool.

Turn on to stop the processor from executing the defined 
configuration. This is useful if the loaded configuration is using 
all the processing time and not allowing DXM Configuration 
Tool operations.
The factory default position is OFF.
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•
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Disable Ethernet Port
Set to ON to power down the Ethernet interface. Disabling the 
unused Ethernet port reduces power consumption.
The factory default position is OFF.

Disable LCD Display
Set to ON to disable the LCD. This DIP switch should be ON 
when the LCD board is not connected.
The factory default position is OFF.

Ethernet
Before applying power to the DXM1200-X2, verify the Ethernet cable is connected.

The number of times the processor attempts to connect to the Ethernet network is configured in the DXM Configuration 
Software (Settings › Network Ethernet Connection Acquisition). The default setting is two retries one minute after the device 
boots up and another retry two minutes later.

The Ethernet connection supports the DXM Configuration Software, Modbus/TCP, and EtherNet/IP. ScriptBasic also has 
access to Ethernet for custom programming. Use the software or LCD menu system to configure the characteristics of the 
Ethernet connection, including the IP address. Any parameters not changeable from the menu system are configurable from 
the configuration software.

Ethernet parameter changes entered through the LCD menu override the XML configuration parameters. To return to using 
the network settings in the XML configuration file, remove the Ethernet parameters defined by the LCD menu using the 
System Config › Ethernet › Reset menu.

USB
A micro USB port is available inside the DXM1200-X2.

The micro USB port can be used to configure the DXM, but a micro USB cable is not provided with the device.

Internal Local Registers (ID 199) for the DXM700, DXM1000, 
and DXM1200
The main storage elements for the DXM1200-X2 are its local registers, which can store 4-byte values that result from register 
mapping, action rules, or ScriptBasic commands.

Local registers updated from Modbus transactions are restricted to a 16-bit data value to follow standard Modbus holding 
register definition.

The local registers defined in action rules must all be within the same register group. For example, an action rule cannot have 
inputs from an integer group with the result register defined as a floating point register. To move between integers and floats, 
use the Register Copy Rule.

Local registers 1–850 and 5001–7000 are 32-bit integer registers
Local registers 851–900 and 7001–8000 are non-volatile 32-bit integer registers
Local registers 901-1000 are reserved for internal use
Local registers 1001–5000 are floating point format numbers, each address stores half of a floating point number; for 
example, registers 1001 and 1002 store the first full 32-bit floating point number
Local registers 10000 and higher are read-only virtual registers; virtual registers collect various system-level data

Modbus registers for internal local registers (Modbus ID 199)

Local Registers Type Description

1–845 32-bit integer Local data registers

846–849 32-bit integer Reset, Constant, Timer

851–900 32-bit non-volatile integer Data flash, non-volatile

901–1000 Reserved for internal use

1001–5000 Floating point Floating point registers, local data registers

5001–7000 32-bit integer Local data registers

7001–8000 32-bit non-volatile integer Data flash, non-volatile

Continued on page 32
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Local Registers Type Description

> 10000 Read-only virtual registers, system-level data

Local registers 1–850 and 5001–7000 (Internal Processor Memory, 32-bit, Unsigned)—The local registers are the main 
global pool of registers. Local registers are used as basic storage registers and as the common data exchange mechanism. 
External Modbus device registers can be read into the local registers or written from the local registers. The DXM1200-X2, as 
a Modbus client device or a Modbus server device, exchanges data using the local registers. Modbus over Ethernet 
(Modbus/TCP) uses the local registers as the accessible register data.

Local registers 851–900 and 7001–8000 (Data Flash, Non-volatile, 32-bit, Unsigned)—The top 50 local registers are special 
non-volatile registers. The registers can store constants or calibration-type data that must be maintained when power is 
turned off. This register data is stored in a data flash component that has a limited write capability of 100,000 cycles, so these 
registers should not be used as common memory registers that change frequently.

Local registers 1001–5000— These local registers are paired together to store a 32-bit IEEE floating point format number in 
big-endian format. Registers 1001 [31:16], 1002 [15:0] store the first floating point value; registers 1003, 1004 store the 
second floating point number. There are a total of 2000 floating point values; they are addressed as two 16-bit pieces to 
accommodate the Modbus protocol. Use these registers when reading/writing external devices that require Modbus registers 
in floating-point format. Since Modbus transactions are 16 bits, the protocol requires two registers to form a 32-bit floating 
point number.

Virtual registers—The DXM1200-X2 has a small pool of virtual registers that show the internal variables of the main 
processor. Some register values will be dependent upon the configuration settings of the DXM1200-X2. Do not use Read 
Rules to move virtual local registers data into local registers. Use the Action Rule › Register Copy function to move virtual 
local registers into local registers space (1–850).

Modbus registers for virtual registers

Registers Definition

10001 GPS latitude direction (N, S, E, W)

GPS Coordinate Data if the DXM is configured to read an external GPS unit.
10002 GPS latitude

10003 GPS longitude direction (N, S, E, W)

10004 GPS longitude

10011–10012 Resync timer Engineering use

10013–10014 Resync timer rollover Engineering use

10015–10016 Reboot cause (Restart Codes above) Reboot Type

10017–10018 Watchdog reset count Counter to track how many resets have been caused by the Watchdog

10021 IO Board Battery Voltage (mV) mV (Not applicable for DXM700 or DXM1200 models)

10022 IO Board - Incoming Supply Voltage (mV) mV (Not applicable for DXM700 or DXM1200 models)

10023 IO Board Voltage Cut-off Feature
0—No successful readings (Not applicable for DXM700 or DXM1200 models)
1—Normal range

2—Cut-off engaged

10024 IO Board - Battery Charging Current (mA) mA (Not applicable for DXM700 or DXM1200 models)

10025–10026 Http Push SSL Acquires
Statistical counts of connections, disconnections and forced disconnects when the 
DXM1200-X2 creates a connection using SSL/TLS (Encrypted connections)10027–10028 Http Push SSL Releases

10029–10030 Http Push SSL Forced Releases

10031–10032 Http Push Attempts
Statistical counts of connections, disconnections and forced disconnects when the 
DXM controller creates a connection using HTTP non-encrypted10033–10034 Http Push Successes

10035–10036 Http Push Failures

10037–10038 Http Push Last Status

Last DXM1200-X2 push status
0 = Initial state, no push attempt as finished yet
1 = Attempt complete
2 = Attempt aborted

Continued on page 33
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Registers Definition

10039–10040 Cellular Strength, BER

Cellular signal strength. Value range: 0–31
0 = –113 dBm or less
1 = –111 dBm
2–30 = –109 dBm through –53 dBm in 2 dBm steps
31 = –51 dBm or greater
99 = not known or not detectable; BER not used

10055–10056 Alarms, smtp, attempts Email attempts (only available with some model configurations)

10057–10058 Alarms, smtp, fails Email failures (only available with some model configurations)

10100 Number of read maps in default

Read Map statistics

10101 Number of read map successes

10102 Number of read map timeouts

10103 Number of read map errors

10104 Read map success streak

10105 Number of write map successes

Write Map statistics
10106 Number of write map timeouts

10107 Number of write map errors

10108 Write map success streak

10109 Number of passthrough successes

API message passing statistics
10110 Number of passthrough timeouts

10111 Number of passthrough errors

10112 Passthrough success streak

10113 Number of 43 buffer successes

DX80 Gateway automatic messaging buffer statistics
10114 Number of 43 buffer timeouts

10115 Number of 43 buffer errors

10116 43 buffer success streak

11000 Read map success count

Read/Write maps statistics

12000 Write map success count

13000 Read map timeout count

14000 Write map timeout count

15000 Read map error count

16000 Write map error count

17000 Read map success streak

18000 Write map success streak

19000 Read map is in default

TCP Client Statistics--The "x" represents the socket 0 through 4. The flex socket is not used. This range repeats for the next socket.

Register Definition

2x001 Socket x connection attempts (20001 is the first socket, 21001 is the second socket...)

2x003 Socket x connections

2x005 Socket x disconnections

2x007 Socket x transmits

2x009 Socket x receives

2x011 Socket x resolver attempts (reserved)

2x013 Socket x resolvers (reserved)

2x015–2x020 Reserved

Continued on page 34
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Register Definition

2x021 Socket x Rule 0 transmits

2x023 Socket x Rule 0 receives

2x025 Socket x Rule 0 timeouts

2x027 Socket x Rule 0 broadcasts

2x029 Reserved

2x031 Socket x Rule 1 transmits

2x033 Socket x Rule 1 receives

2x035 Socket x Rule 1 timeouts

2x037 Socket x Rule 1 broadcasts

2x039 Reserved

Reset Codes—The reset codes are in virtual register 11015 and define the condition of the last restart operation.

Reset Code Definition

0 Undefined

1 Unknown

2 General

3 Brownout

4 Watchdog

5 User

6 Software

7 Return from backup mode

DXM1200-X2 as a Modbus RTU Client
The DXM can be a Modbus RTU client device to other server devices.

The DXM uses the primary RS-485 port as a Modbus RTU client to control external server devices. All wired devices 
connected to the client RS-485 port must be server devices. As a Modbus RTU client device, the DXM controls external 
servers connected to the primary RS-485 port, the local ISM radio, local I/O base board, and the local display board.

Use the DXM Configuration Software to define operational settings for both the Modbus RTU client port and the Modbus RTU 
server port.
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Set the Client and Server Port Parameters
The basic communications parameters for the RS-485 ports are set in the DXM Configuration Software and are saved in the 
XML configuration file. Each port can have unique settings such as a unique baud rate, parity, timeout, and delays between 
messages.

RTU Configuration screen for ports 0-4

◦
◦

◦

Define the Port settings to be compatible with the connected devices.

Verify the Baud Rate and Parity match that of the connected Modbus server devices.
The Timeout controls how long the DXM1200-X2 waits before determining a command failed to send. Set 
based on the specific application requirements.
The Delay between messages defines the minimum wait time between resending another command. Set 
based on the specific application requirements.

1. 
Go to the Register Mapping › RTU › RTU Configuration screen.

RTU Configuration screen

a. 

Go to the Register Mapping › RTU › RTU Configuration screen.b. 
Modify the Port settings as needed.c. 

To set the Modbus server parameters for Port 0, go to Settings › System › Server Port 0 Settings.2. 

Modify the Baud Rate, Parity, and change the Internal Server ID.
The Internal Server ID is the Modbus ID that an external Modbus Client will access to read/write to the local registers 
on the DXM1200-X2.

Server Port 0 Settings

3. 
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Cellular modem board (optional)

U.FL antenna
connector
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Cellular Modem Board for LTE
The 4G LTE cellular modem is an optional accessory that is installed on the two 12-pin sockets.

Plug the cellular modem into the right socket (when 
viewing the internal PCB with the connectors at the 
bottom). The SIM card slides into the socket on the back 
of this board.

Cellular Power 
Requirements
If the incoming voltage drops below 11.2 V DC, the 
cellular modem does not turn on and will not turn on until 
the voltage is above 11.8 V DC.

Using the DXM Cellular 
Modem
The DXM cellular modem provides a remote network 
connectivity solution for the DXM1200-X2.

To use the cellular modem:

Activating a Cellular Modem
Follow these basic steps, as detailed in this document, to activate the cellular capabilities of your DXM Controller.

Purchase one of these cellular modem kit models

Cellular Kit Model Kit Description Important Notes

SXI-CATM1VZW-001

Verizon CAT M1 cellular modem using Telit ME910 modem 
kit (Verizon part number SXIM1V). Includes a cellular 
modem, SIM card, internal adhesive antenna, external SMA 
antenna, and antenna cable. The SIM card is specific to the 
LTE-M technology and cannot be used in other cellular 
modems. Requires a LTE Verizon cellular wireless plan 
attached to the ICCID (SIM card) number and IMEI 
(International Mobile Equipment Identity) number.
Cellular plans can be purchased through 
celldata.bannercds.com.

This cellular modem kit is for use in applications that 
require monthly data usage approaching 50 MB or 250 
MB with push intervals no more frequent than every 10 
minutes. This modem is only for use in the contiguous 
United States region.
Please visit our support site for more details on 
coverage areas and cellular plan pricing.

Continued on page 37

Cellular Modem BoardsChapter 5 

Verify the cellular modem is installed and the correct antenna is connected to the cellular antenna port.1. 
Activate the cellular service.2. 
Configure the DXM1200-X2 to use the cellular network as the network interface.3. 

Purchase a cellular modem kit from Banner Engineering Corp.1. 
Install the cellular modem, connect the antenna cable, and connect the cellular antenna.2. 
Activate a cellular plan to the SIM card, then insert the SIM card into the cellular modem.3. 
Configure the DXM to use the cellular modem.4. 

http://celldata.bannercds.com
http://support.bannercds.com/home/pricing/how-to-choose-a-cellular-service-plan/
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Continued from page 36

Cellular Kit Model Kit Description Important Notes

SXI-CATM1ATT-001

AT&T CAT M1 cellular modem using Telit ME910 modem kit 
(AT&T part number SXIM1A). Includes a cellular modem, 
SIM card, internal adhesive antenna, external SMA antenna, 
and antenna cable. The SIM card is specific to the LTE-M 
technology and cannot be used in other cellular modems. 
Requires a LTE AT&T cellular wireless plan attached to the 
ICCID (SIM card) number and IMEI (International Mobile 
Equipment Identity) number.
Cellular plans can be purchased through 
celldata.bannercds.com.

This cellular modem kit is for use in applications that 
require monthly data usage approaching 50 MB or 250 
MB with push intervals no more frequent than every 10 
minutes. This modem is only for use in the North 
American region.
Please visit our support site for more details on 
coverage areas and cellular plan pricing.

SXI-CATM1WW-001

Worldwide CAT M1 cellular modem using Telit ME910 model 
kit. Includes a cellular modem, SIM card, internal adhesive 
antenna, external SMA antenna, and antenna cable. The 
SIM card is specific to the LTE-M/NB-IoT technology and 
cannot be used in other cellular modems. Requires an LTE 
cellular plan attached to the ICCID (SIM card) number and 
IMEI (International Mobile Equipment Identity) number.
Cellular plans can be purchased through 
celldata.bannercds.com or a local roaming SIM provider.

This cellular modem kit is for use in applications that 
require monthly data usage approaching 50 MB or 250 
MB with push intervals no more frequent than every 10 
minutes. This modem is only for use in the European
region within those countries that are members of the 
EU/EEA and adopt RED/CE compliant products.
Please visit our support site for more details on 
coverage areas and cellular plan pricing.

SXI-LTE-001

Verizon LTE cellular modem using Telit LE910 modem kit 
(Verizon part number SENSX002). Includes a cellular 
modem, SIM card, antenna, and antenna cable. The SIM 
card is specific to the LTE technology and cannot be used in 
other cellular modems. Requires a LTE Verizon cellular 
wireless plan attached to the ICCID (SIM card) number and 
IMEI (International Mobile Equipment Identity) number.
Cellular plans can be purchased through 
celldata.bannercds.com or a local roaming SIM provider.

This cellular modem is only used with the Wireless 
Network Bridge Hub (NET-HUB).
Please visit our support site for more details on 
coverage areas and cellular plan pricing.

For additional information, refer to the Banner Cloud Data Services support center (support.bannercds.com). The support 
center includes video tutorials, product documentation, technical notes, and links to download configuration software.

IMPORTANT: Only the DXM100 and DXM150 models in conjunction with an SXI-LTE-001 (obsolete) 
cellular modem can offer SMS/text messaging capabilities directly from the device. Contact a support 
specialist at Banner Engineering for configuration instructions, or SMS/text messaging can be delivered 
using the Banner CDS web service from any DXM model. 

Install the Cellular Modem (DXM100, 150, 700, and 1000 Models)
Follow these steps to install the cellular modem and antenna cable.

IMPORTANT:
Electrostatic discharge (ESD) sensitive device
ESD can damage the device. Damage from inappropriate handling is not covered by warranty.
Use proper handling procedures to prevent ESD damage. Proper handling procedures include 
leaving devices in their anti-static packaging until ready for use; wearing anti-static wrist straps; 
and assembling units on a grounded, static-dissipative surface.

Installing the cellular modem

1

2 3

SIM cards come in a credit card sized carrier. Carefully snap it out of the carrier.1. 

Make note of the IMEI number of the cellular modem and the ICCID number of the SIM card.
The numbers can be found on the cellular modem and the SIM card or SIM card carrier. You will need the SIM 
number to associate a wireless plan to this SIM card.

2. 

http://celldata.bannercds.com
http://support.bannercds.com/home/pricing/how-to-choose-a-cellular-service-plan/
http://celldata.bannercds.com
http://support.bannercds.com/home/pricing/how-to-choose-a-cellular-service-plan/
http://celldata.bannercds.com
http://support.bannercds.com/home/pricing/how-to-choose-a-cellular-service-plan/
http://support.bannercds.com
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Install the Cellular Modem (DXM1200 Models)
Follow these steps to install the cellular modem and antenna cable.

IMPORTANT:
Electrostatic discharge (ESD) sensitive device
ESD can damage the device. Damage from inappropriate handling is not covered by warranty.
Use proper handling procedures to prevent ESD damage. Proper handling procedures include 
leaving devices in their anti-static packaging until ready for use; wearing anti-static wrist straps; 
and assembling units on a grounded, static-dissipative surface.

Installing the cellular modem

1

2 3

Insert the SIM card into the socket on the underside of the cellular modem while ensuring the conductive pads on the 
SIM card are interfacing with the terminals of the modem.
There is a matching notch in the socket and SIM card that will only allow the SIM to be inserted with one orientation. 
Do not force the SIM card into the socket.

3. 

◦

◦

Orient the cellular modem according to the pin layout.

DXM100, 150, and 1000

Modem

*SIM card is located on the underside of installed modem

Antenna Cable

DXM700

Modem

*SIM card is located on the underside of installed modem

Antenna Cable

For the DXM100, DXM150, and DXM1000 models—Install the cellular modem board onto the processor 
board as shown. Use the diagram to verify the orientation is correct.
For the DXM700 models—Install the cellular modem board onto the base board as shown. Use the diagram to 
verify the orientation is correct.

4. 

Verify the pins are properly aligned.a. 
Verify the hole in the cell modem aligns with the hole on the DXM board.b. 
Firmly press the modem into the 24-pin socket.c. 

Attach the antenna cable between the cellular modem board to the base board as shown.5. 

Install the external cellular antenna on the DXM's SMA connector located next to the antenna cable.6. 

SIM cards come in a credit card sized carrier. Carefully snap it out of the carrier.1. 

Make note of the IMEI number of the cellular modem and the ICCID number of the SIM card.2. 
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Activate a 4G LTE CAT M1 Cellular Plan
Activate a cellular plan for your DXM1200-X2 using the Banner Cloud Data Services website.

The numbers can be found on the cellular modem and the SIM card or SIM card carrier. You will need the SIM 
number to associate a wireless plan to this SIM card.

Insert the SIM card into the socket on the underside of the cellular modem while ensuring that the conductive pads on 
the SIM card are interfacing with the terminals of the modem.
There is a matching notch in the socket and SIM card that will only allow the SIM to be inserted with one orientation. 
Do not force the SIM card into the socket.

3. 

Apply the internal antenna as shown paying attention to the antenna cable position.4. 
Pull back the adhesive protective paper from the middle of the antenna, only exposing the middle portion. 
Antenna application is easier if just a small middle portion of the adhesive is uncovered.

a. 

Center the antenna on the side wall. Use the exposed adhesive in the middle of the antenna to hold the 
antenna in place while aligning the antenna to the full length of the housing.

b. 

Slowly peel off the paper backing exposing the adhesive and stick to the plastic housing. The antenna should 
run below the rim of the housing.

c. 

Press firmly.d. 

Orient the cellular modem according to the diagram below.
The cellular modem is inserted into the main board with the antenna cable from the applied internal antenna attached 
to the cellular modem PCB.

Internal view of a DXM1200

*SIM card is located on the underside of installed modem

Cell Modem

Antenna Cable

SIM card*
location Micro USB

ISM
Radio
Board

Cellular Antenna Placement

5. 

Verify the pins are properly aligned.a. 
Verify the hole in the cell modem aligns with the hole on the DXM board.b. 
Firmly press the modem into the 24-pin socket.c. 

Attach the antenna cable between the cellular modem board to the base board. The antenna cable uses the top 
antenna connection.

6. 

Go to celldata.bannercds.com to purchase cellular data plans.1. 

If you have previously created an account, click Login and enter your username and password to continue.2. 

If you are creating a login for the first time:3. 
Select the region in which the device will operate.a. 
Select the cellular subscription plan. Please use the calculator and regional coverage information to determine 
the plan needed for your device (https://www.bannerengineering.com/us/en/products/wireless-sensor-
networks/iot-cloud-cellular-data-services/cellular-data-plans/Service-Plan-Calculator.html).

b. 

Create a username and password (use an email address for the username).c. 
Enter your payment information, mailing address, agree to the terms and conditions.d. 

Go to the My Services and Equipment section.4. 

Enter the SIM Number (ICCID) and the Module Number (IMEI).
The ICCID is the 20-digit number of the SIM, the bottom barcode number on the SIM card carrier. If the carrier card is 
not available, the ICCID is also printed on the SIM card, but must be removed from its socket to be read. The IMEI is 
the 15-digit number on top of the 4G LTE device.

5. 

Click Activate.6. 

http://celldata.bannercds.com
https://www.bannerengineering.com/us/en/products/wireless-sensor-networks/iot-cloud-cellular-data-services/cellular-data-plans/Service-Plan-Calculator.html
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Activate a Worldwide 4G LTE MNB-IOT Cellular Plan (RED-CE)
The Worldwide 4G LTE-M/NB-IOT cellular modem is operational in those European countries that are members of the EU/
EEA and adopt RED/CE-compliant products.

An international roaming SIM is provided with the Worldwide module and may be activated following the steps listed in 
"Activate a 4G LTE CAT M1 Cellular Plan" on page 39. However, there may be regions that are not covered by the provided 
SIM card. In this case, a local SIM card must be activated and operated with this device to acquire connectivity services.

Configure the DXM Controller for a Cellular Modem
Use the DXM Configuration Software to create a configuration using a cellular connection.

IMPORTANT: Only the DXM100 and DXM150 models in conjunction with an SXI-LTE-001 (obsolete) 
cellular modem can offer SMS/text messaging capabilities directly from the device. Contact a support 
specialist at Banner Engineering for configuration instructions, or SMS/text messaging can be delivered 
using the Banner CDS web service from any DXM model.  

Enter the ICCID and IMEI numbers then click Activate

Although new activations are typically functional in 20 minutes or less, it may take up to 24 hours for the cellular plan 
to become active on the wireless network.

Work with the local Banner technical support person to identify and purchase machine-to-machine (M2M) (data plan 
only) SIM cards in 3FF 'micro' form factor.
Typical monthly data use will be 20-50 MB per month. When choosing a plan, pay close attention to data rates.

1. 

When activating the SIM, note the Access Point Name (APN) that the SIM provider states to use with their SIM.
The IMEI is the 15-digit number on top of the cell module PCB, below the words Telit ME910G1-WW and above the 
barcode. The ICCID is the 20-digit number printed on the SIM card itself.

2. 

Go to the Settings › Cloud Services screen.1. 

Set the Push Interface to Cell
All push data will be sent using the cellular modem.

2. 

◦

◦

◦

Go to the Settings › Cellular screen. Under the Cell Configuration section, select the Cell module from the drop-down 
list.

For the United States (contiguous)—For Verizon LTE/CATM modems, select SXI-LTE-001 or SXI-
CATM1VZW-001 and set the APN to vzwinternet.
For North America—For ATT LTE/CATM modems, select SXI-CATM1ATT-001 and set the APN to 
iot0119.com.attz. Requires a SIM module to be purchased from a wireless carrier based on the IMEI number 
of the cellular modem. The wireless carrier will provide the APN parameters. Not all parameters may be 
required.
For regions outside of North America—Select SXI-CATM1WW-001 and set the APN to m2m.tele2.com when 
using the SIM card provided with the kit from Banner Engineering. When using a local roaming SIM, please 
use the APN as suggested by your cellular connectivity (SIM) provider.

3. 

To send data to the webserver, complete the parameters on the Settings › Cloud Services screen. Set the Cloud push 
interval and the Web Server settings. (For more information, refer to the DXM Configuration Software Instruction 
Manual (p/n 201127).

4. 

http://info.bannerengineering.com/cs/idcplg?IdcService=GET_FILE&dDocName=201127&RevisionSelectionMethod=Latest&Rendition=web


Cellular Modem Boards DXM1200-X2 Controller Product Manual

04-Nov-25 page 41 of 76© Banner Engineering Corp. All rights reserved. 
www.bannerengineering.com

IMPORTANT: Banner Engineering offers several prepackaged solutions that report to the Banner Cloud 
Data Services web-based software platform via cellular connectivity. Many of these solutions execute the 
data push using a ScriptBasic file instead of the XML configuration file. If you are using a Banner 
prepackaged solution (ex. SOLUTIONSKIT9-VIBE), then you do not need to set the Cloud Push Interval
on the Settings › Cloud Services screen. You still need to set the Push Interface to Cell and select the 
appropriate Cell Module and APN.

When the DXM1200-X2 is configured to use the cellular modem, the information on the cellular modem is found on the LCD 
menu under System Info › Cell. The menu does not display values until a transaction with the wireless cell tower is complete.

The Settings › Cellular screen

If there are no webserver parameters defined, the user must force a push to retrieve the data from the cellular network. On 
the LCD menu, select Push › Trigger Data Push.

Obtaining LTE service outside of the Banner Cellular Data Plans—Customers have the option of securing a data plan for the 
Verizon network themselves without using the Banner cellular data portal (celldata.bannercds.com). Suitable plans would 
include those available from Verizon directly or from a Mobile Virtual Network Operator (MVNO) licensed to resell Verizon 
network data plans. (The SXI-LTE-001 or SXI-CATM1VZW-001 will not function on AT&T, T-Mobile, or Sprint networks.) 
When purchasing a data plan, it is important to refer to the modem by its official Verizon network name (for example, 
SENSX002) and give the IMEI number (found on the cellular modem) to the plan provider. To use the SIM card that comes 
with the cellular modem kit, give the SIM card number to the provider. The required SIM card form factor is 3FF - Micro.

The Settings › Cloud Services screen

http://celldata.bannercds.com
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Top-level menu

Banner Eng
→ Registers
→ S →
→

→
→

↑

↓

ENTER

BACK

→ I/O Board

Push
ISM Radio

System Config
System Info

08:25:15

08:25:45
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The LCD has four user-defined LED indicators, four control buttons, and an LCD. The four buttons control the menu system 
on the LCD menu.

The top-level menu always displays the time in a 24-hour 
format.

The up and down arrows scroll through display items.
The ENTER button selects the highlighted items on the 
display.
The BACK button returns to a previous menu option.

The left display column shows an arrow at the beginning of the 
line if the menu has submenus. The right column shows a 
vertical line with an arrow at the bottom if the user can scroll 
down to see more menu items.

The DXM can be configured to require a passcode be entered 
before the LCD and Menu system will operate. The passcode 
configuration is defined in the DXM Configuration Software.

Registers
The Registers submenu displays the processor's local registers that can be configured using the DXM Configuration 
Software.

Registers menu

Registers List of Local Register
Values and the Register Name to change the value

to acceptENTER

BACK to return to the previous menu

↑ ↓

To configure these local registers, launch the DXM Configuration Software. Go to Local Registers and expand the view for a 
local register by clicking on the down arrow next to the register number. In the LCD Permissions field, select None, Read, 
Write, or Read/Write.

Read allows the register to be displayed and Write or Read/Write allows the register value to be changed using the LCD. The 
Units and Scaling parameters are optional and affect the LCD.

LCD and Menu SystemChapter 6 
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Push
The Push menu displays information about the last data sent to the Webserver.

Push menu

Push Trigger Data Push Trigger Data Push

to change the value

to acceptENTER

BACK to return to the previous menu

↑ ↓Status
Time (hh:mm:ss)

The user can force an immediate push to the webserver using Trigger Push. If a current push is in process it may take 
several minutes to complete over cellular.

The Trigger Push submenu forces an immediate push to the web server.
The status and time fields indicate the success or failure of the last attempted push and the time of the last attempted 
push.

ISM Radio
The ISM Radio menu allows the user to view the Modbus ID of the internal ISM radio, enter binding mode, or run a site 
survey. This top-level ISM Radio menu is different from the System Config › ISM Radio submenu.

ISM Radio menu

ISM Radio MultiHop/DX80 ID

Binding

Site Survey

Bind to > 1

Node/Modbus ID > 1

to change the value

to acceptENTER

BACK to return to the previous menu

↑ ↓

Please Wait...

Site Survey results OR Failed to start Site Survey

The first option under the ISM Radio menu only displays the type of radio in the DXM1200-X2 (MultiHop or DX80 Star) and 
the Modbus ID of the radio. To change the ISM Radio Modbus ID refer to the System menu.

Select Binding to enter binding mode or select Site Survey to run a site survey.

Binding— All ISM radio devices must be bound to the internal Gateway/client device before the DXM1200-X2 can access 
wireless devices. The first submenu under binding allows the user to set the wireless address of the device to bind with. This 
is required to bind with wireless devices that do not have rotary dials (for example M-GAGEs, ultrasonic sensors, and Q45 
devices). See "Binding and Conducting a Site Survey with the ISM Radio" on page 14. For more information on binding a 
particular device, refer to the individual datasheet.

Site Survey—After creating a wireless network using the binding process, run a site survey on each device to see the link 
quality. See "Conduct a Site Survey from the DXM" on page 15.
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System Config
Use the System Config menu to set DXM1200-X2 system parameters.

System Config menu

System Config ISM Radio

to change the value

to acceptENTER

BACK to return to the previous menu

↑ ↓

Ethernet

Provision Cell
DXM Modbus ID: xxx
LCD Contrast: xx
Restart

DX80 ID: x
Auto Detect Radio

Advanced Options

Max Node Count: xx
Binding #: xxxxxx
RF Ctrl: Dip 1.00W

Ref Type: DX80
Ref Modbus ID: x

New ISM Modbus ID: x
Radio Detected Type: DX80
ID: 1

New ISM Max Nodes: xx
New ISM Binding Code: xxxxxx

DHCP Update DHCP Mode
IP:
SN:
GW:
Reset

Update IP Address
Update SN
Update GW Address
Resets Ethernet parameters
to xml defaults.

After making changes to the
Ethernet settings, restart the DXM.

The System Config submenus are:
ISM Radio
Ethernet
Provision Cell
DXM Modbus ID
LCD Contrast
Restart

ISM Radio
DX80/MultiHop ID—The ISM radio is set at the factory to be Modbus device address 1 (Modbus ID 1). For some applications, 
you may need to change the Modbus ID. Adjust the Modbus device address using the LCD menu system. Any other method 
may cause issues with the DXM1200-X2 not knowing which Modbus device address is assigned to the radio, which causes 
issues with running Binding or Site Survey from the LCD menu.

Set the radio Modbus ID to a valid number (1 through 247) that is not being used by the DXM system. Processor Local 
Registers allocate ID 199, the I/O board is set to ID 200, and the display board is set to ID 201. With a DX80 Gateway (star 
network), it's easy to choose a new ID. With a MultiHop network, remember that the client MultiHop radio allocates a range of 
Modbus IDs for wireless devices, typically 11 through 110.

When setting the new ISM Modbus ID, the system changes the Modbus ID on the internal radio and changes the reference to 
it on the DXM1200-X2. The reference Modbus ID is what the DXM1200-X2 uses to access the internal radio when running 
Binding or Site Survey.

Auto Detect Radio—If the internal Modbus ID of the radio was changed or the internal radio was changed, but not recorded, 
use Auto Detect Radio to determine the radio ID and radio type. The auto-detect routine broadcasts discovery messages and 
waits for a response. If other devices are connected to the external RS-485 ports, they may need to be disconnected for this 
process to work properly.

Advanced Options—The Advanced Options menu is typically not used unless the Modbus ID is changed without the 
DXM1200-X2 being involved, such as when you write directly to the radio Modbus registers.

Reference Type selects the radio type between DX80 star architecture radios and a MultiHop radio. The DXM1200-X2
uses this reference to determine how to communicate to the internal radio. If set incorrectly, the DXM1200-X2 may 
not be able to run Site Survey from the LCD menu. Unless you are changing or adding the internal radio device, there 
should no reason to change the radio type.
Reference Modbus ID defines the Modbus ID the DXM1200-X2 uses when communicating with the internal radio. If 
this is set incorrectly, the DXM1200-X2 will not be able to run Binding or Site Survey through the LCD menu.

Max Node Count—Defines the maximum number of devices for the DX80 wireless network.
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Binding #—This parameter allows the user to define the Binding code within the ISM radio. Typically, you will not have to 
adjust this number unless you are replacing an existing Gateway or client radio.

RF Ctrl—Displays the status of the ISM radio DIP switch 1 (off or on). The menu doesn't allow the user to change the DIP 
switch setting through the display.

Ethernet
Use the Ethernet submenu to sets the IP Address, Gateway Address, and Subnet mask of the DXM1200-X2's Ethernet 
interface. You may change these settings either from the LCD menu (System Config › Ethernet) or from the XML 
configuration file created by the DXM Configuration Software.

The network address settings from the LCD menu have the highest priority and override settings in the XML configuration file. 
To use the parameter settings from the XML configuration file or use DHCP, execute the Reset under System 
Config › Ethernet or use the LCD to set the IP Address, Gateway Address, and Subnet Mask to 255.255.255.255. Reboot the 
DXM1200-X2 after changing the Ethernet parameters.

The Ethernet cable should be attached before powering up the DXM1200-X2.

LCD Contrast
Use the LCD Contrast option to adjust the LCD contrast. Adjust the starting number lower to decrease the display contrast. 
The factory default is 28. Do not set a number less than 15 or the display may not be bright enough to see to change back.

Reset
Use the Restart menu to force the main processor to restart. This does not affect the other boards in the system.

System Info
Various DXM system settings are shown in this menu. The Push, Ethernet, and Cell parameters are helpful for debugging 
network connections. This is a read-only menu.

System Info menu

System Info Controller

Push

ISM Radio

Date:
Firmware:
Build:
Model:
Serial:
Method:
Interval: hh:mm
URL:
Page:
Https: on/off
Site ID:

Serial:
Model:
Date:
RF FW Pt:
RF FW Ver:
RF EE Pt:
RF EE Ver:

to change the value

to acceptENTER

BACK to return to the previous menu

↑ ↓

Ethernet DHCP:
IP:
Subnet:
Gate:
Mac:
DNS1:
DNS2:

Cell Signal:
Phn#:
Dev#:
SIM:
CellVer:
CellMdl:
CellFw:
CellMask:

Wifi IP:
Mode:
AP:
Stat:

Script Path:
Baud:
Code:  

LCD Board Serial:
Model:
Date:
RF FW Pt:
RF FW Ver:
RF EE Pt:
RF EE Ver:

Cell Shows the cellular MEID number (Mobil Equipment Identifier), 
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MDN (Mobil Device Number), version, signal, firewall setting, 
and firewall mask. Some of these parameters are not visible 
until the cellular network is accessed.

Controller
Displays the date, build, model, and serial number.

Ethernet
Displays the IP address, MAC address, DHCP, Gateway 
address, and DNS settings.

ISM Radio
Displays the serial number, model, date, firmware part 
numbers, and version numbers.

LCD Board
Displays the serial number, model, date, firmware part 
numbers, and version numbers.

Push
Shows the current parameters loaded from the XML 
configuration that applies to pushing data to a webserver, 
including method (Ethernet or cellular), interval, URL, page, 
HTTPS, and site ID.

Script
Displays the name of the ScriptBasic file running.

Wi-Fi
Displays the Wi-Fi IP address and other settings.

Display Lock
Display Lock protects the DXM LCD menu system from being used until the proper passcode is entered.

Display Lock menu

Display Lock Enter password
>> x to change the value

to acceptENTER

BACK to return to the previous menu

↑ ↓

The display lock feature uses the configuration software to set a passcode within the DXM. A valid passcode is 1 to 9 digits 
long and uses numbers 0 through 9. For example, 1234 or 209384754.

DXM1200-X2 Modbus Registers for the LCD (Modbus ID 201)
Control the four bi-color LEDs using the display's Modbus registers. Using write maps or ScriptBasic, write the Modbus 
registers shown below with 0 (off) or 1 (on).

Modbus registers for the LCD board (Modbus ID 201)

Modbus Register LED Color State

1102 : bit 0 LED 1 Red

1 = On
0 = Off

1103 : bit 0 LED 2 Green

1104 : bit 0 LED 3 Blue

1105: bit 0 LED 4 Amber

1106: bit 0 Backlight

Modbus registers for the RGB indicator

Modbus Registers Colors

Group A Group B Off Blue Green Teal Red Violet Yellow/Green White/Blue

1107 1110 0 1 0 1 0 1 0 1

1108 1111 0 0 1 1 0 0 1 1

1109 1112 0 0 0 0 1 1 1 1

The primary DXM1200 light is created by two sets of three grouped LEDs (blue, green, and red).

One set of blue LEDs is controlled with register 1107 and another set of blue LEDs is controlled by register 1110.

One set of green LEDs is controlled with register 1108 and another set of green LEDs is controlled by register 1111.

One set of red LEDs is controlled with register 1109 and another set of red LEDs is controlled by register 1112.
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Turning both groups on for the same color increases the intensity of the light. For example, setting registers 1107 and 1110 to 
1 doubles the number of LEDs turned on, effectively doubling the intensity of the blue color.
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The DXM1200-X2 has two physical RS-485 connections using Modbus RTU protocol.

The client Modbus RS-485 port is for the DXM1200-X2 to act as a Modbus client device to control internal and external 
Modbus server devices. The Modbus client RS-485 port uses the white (+) and black (-) wires on the M12 quick disconnect 
connector.

DXM1200-X2 system overview

Ethernet

RS-485 (client)

Internal
Micro USB

Processor/Outputs (Base Board)
Local Registers
(Modbus ID 199)

Processor Controller

ISM Radio (Modbus ID 1)

User Display (Modbus ID 201)

Local Registers
Integer

Local Registers
Float

Local Registers
Non-Volatile

Cellular Modem

Modbus Data Traffic
Control

Gateway or MultiHop

LCD / LED

The DXM1200-X2 operates the Modbus client port. Each device on the client port must be assigned a unique server ID. 
There are server IDs that are reserved for internal devices in the DXM1200-X2.

DXM internal Modbus IDs (factory default)

Modbus ID  Device 

1  DX80 Performance Gateway or MultiHop ISM Radio—MultiHop wireless devices connected to the internal MultiHop radio 
should be assigned Modbus IDs starting at 11. 

199  Local Registers—Internal storage registers of the DXM1200-X2 

201  LCD—The user has access to the LED indicators on the DXM1200-X2. 

Assigning Modbus IDs
Set the DXM ID from the LCD menu under System › DXM Server ID. The DXM1200-X2 can have any unique ID.

DXM Client Configuration—When the DXM1200-X2 operates as a Modbus client device, use the DXM Configuration 
Software to configure read or write operations of the DXM Modbus network. The DXM1200-X2 communicates with all internal 
and external peripheral devices using the external Modbus bus RS-485.

Working with Modbus DevicesChapter 7 
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There are four internal Modbus server devices that are configured from the factory with Modbus IDs. Assign IDs of 2 through 
10 to Modbus server devices that are physically wired to the DXM1200-X2. Assign IDs or 11 through 60 to wireless servers 
within the MultiHop network.

Do not assign an ID of greater than 10 to Modbus server devices that are physically wired using the RS-485 port if there is an 
internal MultiHop ISM radio in the DXM1200-X2. The MultiHop ISM radio attempts to send any Modbus data intended for IDs 
11–60 across the radio network, which conflicts with wired server devices if the IDs overlap. The MultiHop client radio can be 
changed from the factory default of 11–60 Modbus IDs if more hardwired servers are required.

Modbus Operation
All Modbus transactions are managed by a central Modbus engine. If there are Modbus messages intended for a Modbus 
server that doesn't exist, the Modbus engine waits for a response until the timeout period is expired. This slows down the 
Modbus polling loop for read and write operations.

For this reason, verify all Modbus read and write operations are intended for Modbus server devices that are in the network. If 
a Modbus server is not in the network, either a wired or wireless device, the operation of the LCD menu system can be 
compromised. Operations like Binding, Site Survey, or accessing the ISM menu may be slower. This is because all internal 
devices (such as the ISM radio, LCD, etc) of the DXM1200-X2 are also Modbus servers.

Wireless and Wired Devices
Wireless DX80 Performance Gateway—The DX80 Performance Gateway architecture is a star architecture in which all 
Nodes in the system send their data back to the Gateway. The host can access the entire network data from the Gateway, 
which is Modbus ID 1. Because the DXM1200-X2 will not be sending any Modbus messages across the wireless link, the 
timeout parameter can be set low (less than 1 second) and the device is treated like a directly connected device.

MultiHop Client—The MultiHop client radio forms a wireless tree network using repeaters and server devices. Each device in 
a MultiHop network must be assigned a unique Modbus ID and is accessed as a separate device.

For the DXM1200-X2 to talk with a MultiHop device in the wireless network, the client MultiHop device interrogates every 
message on the RS-485 bus. If they are within the wireless device range (IDs 11 though 60), the message is sent across the 
wireless network. To change this range, the user must adjust the offset and range setting in the MultiHop client radio (Modbus 
ID 1). Modbus register 6502 holds the Modbus offset, default 11. Modbus register 6503 holds the number of Modbus servers 
allowed (maximum of 100).

Modbus IDs for wireless and wired devices

Modbus ID Description

1 Allocated for the internal ISM radio device, either a DX80 Performance Gateway or MultiHop Client

2–10 IDs available for direct-connected Modbus server devices to the client RS485 port (M+ , M-)

11–60 Allocated for wireless MultiHop radio network devices. If there is not an internal MultiHop in the DXM1200-X2, these server 
addresses are available to use for directly connected devices.

61–198 Available to users for direct-connected Modbus server devices or the expansion of the wireless network server IDs to go past 50 
wireless devices.

199 Allocated for internal Local Register

201 Allocated for the LCD display board, the user can read/write LEDs.

Modbus Communication Timeouts
A Modbus timeout is the amount of time a Modbus server is given to return an acknowledgment of a message sent by the 
Modbus client. If the Modbus client waits for the timeout period and no response is seen, the Modbus client considers it a lost 
message and continues on to the next operation.

The timeout parameter is simple to set for Modbus devices directly connected to the DXM1200-X2, if there are no MultiHop 
wireless devices. Special considerations need to be made to set the timeout parameter when a MultiHop network uses the 
DXM1200-X2 as the client radio.

Configure controllers operating wireless networks to allow for enough time for hardware transmission retries. Set the 
Communications Timeout parameter to cover the expected time for messages to be sent throughout the wireless network. 
For the DXM1200-X2, the Communications Timeout parameter is the maximum amount of time the DXM1200-X2 should wait 
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after a request is sent until the response message is received from the Modbus server device. Use the DXM Configuration 
Software to set the timeout parameter on the Settings › System screen (select Show advanced settings).

The default setting for the timeout parameter is 5 seconds.

MultiHop Networks vs DX80 Star Networks
The DX80 star Gateway collects all the data from the Nodes, which allows the host system to directly read the data from the 
Gateway without sending messages across the wireless network. This allows for DX80 Gateway to be treated like any other 
wired Modbus device.

In a MultiHop network, the data resides at each device, forcing the controller to send messages across the wireless network 
to access the data. For this reason, carefully consider the value of the wireless timeout parameter.

Calculating the Communications Timeout for Battery-Powered MultiHop Radios
Battery-powered MultiHop radios are configured to run efficiently to maximize battery life. By optimizing battery life, the 
allowed communications window to receive messages is slow (once per 1.3 seconds) and sending message rates are 
standard (once per 0.04 seconds).

A MultiHop device is set from the factory with the retry parameter of 8. This means that under worst-case conditions, a 
message is sent from the DXM1200-X2 to an end device a total of nine times (one initial message and eight retry messages). 
The end device sends the acknowledgment message back to the DXM1200-X2 a maximum of nine times (one initial 
message and eight retries). A single Modbus transaction may send up to two messages + 16 retry messages before the 
transaction is complete. In addition, the radios randomly wait up to one time period before retransmitting a retry message. So 
to allow for the random wait time, add one extra time period for each in-between time of retries.

To calculate the communication timeout parameter for a client to a server radio (no repeaters):
Client to Server Send time = (9 × 1.3 sec) + (8 retry wait × 1.3 sec) = 22 seconds
Server to Client Send time = (9 × 0.04 sec) + (8 retry wait × 0.04 sec) = 1 second
Total Send/Receive time = 23 seconds
Minimum Timeout period = 23 seconds

If the link quality of the network is poor, the maximum transfer times may happen. Set the timeout parameter to accommodate 
the maximum number of retries that may happen in your application.

When MultiHop repeaters are added to the wireless network, each additional level of hierarchical network increases the 
required timeout period. Since MultiHop repeaters are running at the highest communications rate, the overall effect is not as 
great.

Client to Repeater Send time = (9 × 0.04 sec) + (8 retry wait × 0.04 sec) = 1 second
Repeater to Client Send time = (9 × 0.04 sec) + (8 retry wait × 0.04 sec) = 1 second
Additional Timeout period for a repeater = 2 seconds

Using the timeout calculation above of 23 seconds, if a repeater is added to the network the timeout should be set to 25 
seconds. For each additional MultiHop repeater device creating another level of network hierarchy, add an additional two 
seconds to the timeout period.

Calculating the Communication Timeout for 10–30 VDC MultiHop Radios
Line-powered (10–30 V DC) MultiHop devices operate at the maximum communication rate, resulting in a much lower 
timeout parameter setting. For each repeater added to the network, increase the timeout parameter 2 seconds.

For a client radio to a 10–30 V DC powered server radio (no repeaters):
Client to Server Send time = (9 × 0.04 sec) + (8 retry wait × 0.04 sec) = 1 second
Server to Client Send time = (9 ×* 0.04 sec) + (8 retry wait × 0.04 sec) = 1 second
Total send/receive time = 2 seconds
Minimum timeout period = 2 seconds

Adjusting the Receive Slots and Retry Count Parameters
The number of receive slots governs how often a MultiHop device can communicate on the wireless network.

Battery-powered devices typically have DIP switches that allow the user to set the number of receive slots, which directly 
affects the battery life of the radio. Adjusting the receive slots changes how often a message can be received. By default, the 
receive slots are set to 4 (every 1.3 seconds). When the receive slots are set to 32, the radio listens for an incoming message 
every 0.16 seconds.
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Users may also leave the retry mechanism to the application that is accessing the wireless network, in this case the 
DXM1200-X2. Adjust the number of retries in the MultiHop devices by writing the number of retries desired to Modbus 
register 6012. The factory default setting is 8.

Calculating the Communication Timeout for a DX80 Star Network
In the DX80 network, all Node data is automatically collected at the Gateway to be read. The DXM1200-X2 does not use the 
wireless network to access the data, which allows for much faster messaging and much lower timeout values.

For a DXM1200-X2 with an internal DX80 Gateway, set the timeout value 0.5 seconds. If other Modbus devices are 
connected to the RS-485 lines, the timeout parameter governs all communication transactions and must be set to 
accommodate all devices on the bus.

Modbus TCP Client
The DXM1200-X2 can operate as a Modbus TCP client on Ethernet. Users may define up to five socket connections for 
Modbus TCP server devices to read Modbus register data over Ethernet. Use the DXM Configuration Software to define and 
configure Modbus TCP client communications with other Modbus TCP servers.
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Scheduler
Use the Scheduler screens to create a calendar schedule for local register changes, including defining the days of the week, 
start time, stop time, and register values.

Schedules are stored in the XML configuration file, which is loaded to the DXM1200-X2. Reboot the DXM1200-X2 to activate 
a new schedule.

If power is cycled to the DXM1200-X2 in the middle of a schedule, the DXM1200-X2 looks at all events scheduled that day 
and processes the last event before the current time.

For screens that contain tables with rows, click on any row to select it. Then click Clone or Delete to copy/paste or remove 
that row. 

Create a Weekly Event
Use the Tools › Scheduler › Weekly Events screen to define weekly events.

Scheduler > Weekly Events screen

Register updates can be changed up to two times per day for each rule. Each rule can be set for any number of days in the 
week by clicking the buttons M, T, W, Th, F, S, or Su.

Configuration InstructionsChapter 8 

Click Add Weekly Event.
A new schedule rule is created.

1. 

Click on the arrow to the left of the new rule to expand the parameters into view.
The user-defined parameters are displayed.

2. 

Name your new rule.3. 

Enter the local register.4. 

Select the days of the week this rule applies to.5. 

Enter the starting value for the local register.6. 

Use the drop-down list to select the type of Start at time: a specific time or a relative time.7. 

Enter the starting time.8. 

Enter the end time and end value for the local register.9. 
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If two register changes are defined for a day, define the start time to be before the end time. Select End Value to enable the 
second event in a 24-hour period. To span across two days (crossing the midnight boundary), set the start value in the first 
day, without selecting End Value. Use the next day to create the final register state.

Start and end times can be specified relative to sunrise and sunset, or set to a specific time within a 24-hour period. When 
using sunrise or sunset times, set the GPS coordinates on the device so it can calculate sunrise and sunset.

Create a One-Time Event
Define one-time events to update registers at any time within a calendar year.

Similar to Weekly events, the times can be specific or relative to sunrise or sunset. Define one-time events using the 
Tools › Scheduler › One Time Events screen.

Scheduler > One Time Events screen

Create a Holiday Event
Use the Tools › Scheduler › Holidays screen to create date and/or time ranges that interrupt weekly events.

Scheduler > Holidays screen

Authentication Setup
The DXM1200-X2 has three areas that can be configured to require login and password authentication.

Webserver/ Cloud Services Authentication
Mail Server Authentication
DXM Configuration Authentication

The webserver and mail server authentication depends upon the service provider.

Click on Add One Time Event.
A new one-time event is created.

1. 

Click on the arrow to expand the parameters into view.
The user-defined parameters are displayed.

2. 

Name your one-time event by clicking on the name link and entering a name.3. 

Enter the local register.4. 

Enter the starting time, date, and starting value for the local register.5. 

Enter the ending time, date, and ending value for the local register.6. 

Click on Add Holiday.
A new rule is created.

1. 

Enter a name your new holiday rule.2. 

Select the start date and time for the new holiday.3. 

Select the stop date and time for the new holiday.4. 
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Settings > Administration screen

Set the Controller to use Authentication
The DXM1200-X2 can be configured to send login and password credentials for every HTTP packet sent to the webserver. 
This provides another layer of security for the webserver data.

Configuration requires both the webserver and the DXM1200-X2 to be given the same credentials for the login and 
password. The webserver authentication username and password are not stored in the XML configuration file and must be 
stored in the DXM1200-X2.

Controller Configuration Authentication
The DXM1200-X2 can be programmed to allow changes to the configuration files only with proper authentication by setting 
up a password on the Settings › Administration screen in the DXM Configuration Software.

With the DXM1200-X2 connected to the PC, click Get 
Device Status. The DXM1200-X2 status displays next to 
the button.

Use the DXM Configuration Software to:
Set the Admin Password
Change the Admin Password
Remove the Admin Password

To change or remove an admin password, you are 
required to enter the current password and the 
DXM1200-X2 must be connected to the PC.

From within the DXM Configuration Software, go to the Settings › Cloud Services screen.1. 

In the upper right, select Show advanced settings.2. 

Web Server Authentication screen

Define the username and password in the Web Server Authentication section of the screen.
The first time you select Require Authentication, a pop-up box appears 
with additional instructions. Since the data is not stored in the XML 
configuration file, it is hidden from view of the DXM Configuration 
Software.

3. 

Click on Send Authentication.
The controller must be connected to the PC for this operation to 
succeed.
The data transmits directly to the DXM1200-X2's non-volatile memory. 
If successful, a pop-up window appears, asking to reboot the device.

4. 

Select Yes to reboot the device.5. 



Configuration Instructions DXM1200-X2 Controller Product Manual

04-Nov-25 page 55 of 76

(2) EttherNet/IP is a trademark of Rockwell Automation.

© Banner Engineering Corp. All rights reserved. 
www.bannerengineering.com

Register flow

Remote DevicesEthernet/USB/Cellular

Processor

Local
Registers

Display I/O Base Internal
Radio

Register Flow and Configuration
The DXM1200-X2 register data flow goes through the Local Registers, which 
are data storage elements that reside within the processor.

Using the DXM Configuration Software, the controller can be programmed to 
move register data from the Local Register pool to remote devices, the 
internal radio, the I/O base (if applicable), or the display.

Basic Approach to Configuration
When programming an application in the DXM1200-X2, first plan the overall 
data structure of the Local Registers. The Local Registers are the main 
storage elements in the DXM1200-X2. Everything goes into or out of the 
Local Registers.

Troubleshooting a Configuration
View Local Registers using the Local Registers  › Local Registers in Use screen of the DXM Configuration Software.

When a configuration is running on the DXM1200-X2, viewing the Local Registers can help you to understand the 
application's operation. This utility can also access data from remote devices.

To configure the Local Register data to display on the LCD menu, go to the Local Registers screen, set the LCD permissions
to read or read/write.

Saving and Loading Configuration Files
The DXM Configuration Software saves its configuration information in an XML file. Use the File menu to Save or Load 
configuration files.

Save the configuration file before attempting to upload the configuration to the DXM1200-X2. The DXM Configuration 
Software uploads the configuration file saved on the PC to the DXM1200-X2; it will not send the configuration loaded in the 
tool.

Uploading or Downloading Configuration Files
The DXM1200-X2 requires an XML configuration file to become operational. To upload or download configuration files, 
connect a computer to the DXM1200-X2 using the USB port or Ethernet port. Then use the Upload Configuration to Device or 
Download Configuration from Device under the Device menu.

EtherNetIP Configuration
The DXM1200-X2 is defined from the factory to send/receive register data from the Gateway and the first 16 Nodes with an 
EtherNet/IP™(2) host.

To expand the number of devices going to Ethernet/IP, change the Devices in system parameter in the DX80 Gateway 
(default setting is 8) to 32. To change this value:

In the DXM Configuration Software, name the Local Registers to 
provide the beginning structure of the application.

1. 

Configure the read/write rules to move the data. The Read/Write rules 
are simple rules that move data between devices (Nodes, Modbus 
servers, sensors, etc) and the Local Registers.

2. 

Most applications require the ability to manipulate the Local Register 
data, not just move data around. Use the Action rules to make 
decisions or transform the data after the data is in the Local Registers. 
Action rules can apply many different functions to the Local Register 
data, including conditional statements, math operations, copy 
operations, or trending.

3. 

To perform scheduled events in Local Registers, go to the Scheduler screen in the DXM Configuration Software. 
These rules provide the ability to create register events by day of the week. The scheduler can also create events 
based on sunrise or sunset.

4. 
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This allows the user to maximize the use of the EtherNet/IP buffer to 28 devices.

EDS (Electronic Data Sheet) files allow users of the EtherNet/IP protocol to easily add a Banner DXM device to the PLC. 
Download the EDS files from the Banner website.

DXM EDS Configuration File (for PLCs) (p/n b_4205242)
DXM EIP Config File for DXM Controller with Internal Gateway (Models: DXM1xx-BxR1, DXM1xx-BxR3, and 
DXM1xx-BxCxR1) (p/n 194730)

Configuring the Host PLC
On the host PLC, install the DXM1200-X2 using an EDS file or by using the following parameters:

Assembly1: Originator to DXM = Instance 112, 456 bytes (228 words)
Assembly2: DXM to Originator = Instance 100, 456 bytes (228 words)

The Originator is the host PLC system, and the DXM is the DXM1200-X2. The host system sees the DXM1200-X2 as a 
generic device with the product name of Banner DXM (ProdType: 43 - Generic Device, ProdName: Banner DXM, Integer 
Type - INT).

IMPORTANT: Do not set the Requested Packet Interval (RPI) any faster than Key definition for 
"RPI_SPEED" not found in the DITA map..

Configuring the Controller
Use the configuration software to define the Protocol conversion for each local register to be EIP Originator › DXM or EIP 
DXM › Originator from the Edit Register or Modify Multiple Register screens.

Define a DXM local register as EIP Originator › DXM when the host PLC (Originator) will send data to the DXM1200-X2 local 
register (DXM).

Define a DXM local register as EIP DXM › Originator when that register data will be sent from the DXM1200-X2 (DXM) to the 
host PLC (Originator).

Data from an EIP controller in assembly instance 112 is data destined for the DXM1200-X2 local registers. The PLC is 
normally configured for INT or UINT data transfer. This allows for a seamless transfer of data.

EIP Assembly Instance 112 (16-bit) DXM Local Registers

Adrs Data Adrs Data

0 1122 1 1122

1 3344 2 3344

2 5566 3 5566

3 7788 4 7788

4 9900 5 9900

Data from the DXM1200-X2 local registers is sent to the EIP controller using assembly instance 100. Each local register in 
the DXM1200-X2 defined as EIP DXM › Originator is collected in numerical order and placed into the data buffer destined for 
assembly instance 100. DXM local registers are capable of 32-bits, but only the lower 2-bytes (16-bits) for each local register 
are transferred.

Launch the the DX80 Configuration Software.1. 
In the menu bar, go to Device › Connection Settings and select Serial or Ethernet DXM.2. 
In the Configuration › Device Configuration screen, click on the arrow next to the Gateway to expand and display the 
Gateway's parameters.

3. 

In the System section, use the Devices in system drop-down list to make your selection.4. 

http://info.bannerengineering.com/cs/idcplg?IdcService=GET_FILE&dDocName=b_4205242&RevisionSelectionMethod=Latest&Rendition=web
http://info.bannerengineering.com/cs/idcplg?IdcService=GET_FILE&dDocName=194730&RevisionSelectionMethod=Latest&Rendition=web
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EIP Assembly Instance 100 (16-bit) DXM Local Registers

Adrs Data Adrs Data

0 1122 11 1122

1 3344 12 3344

2 5566 13 5566

3 7788 14 7788

4 9900 15 9900

Define the Network Interface Settings
On the Cloud Services screen (shown with Show advanced settings selected), define the network connection settings by 
selecting Ethernet or Cell from the Network Interface drop-down list. This determines how the DXM1200-X2 sends data.

If you don't require pushing data to a web server, set the Cloud Push interval to zero.

Cloud Services screen

Configure your Ethernet Connection
When selecting Ethernet, go to the Settings › Ethernet screen.

To define the Ethernet IP address, give the DXM1200-X2 a static IP address. In most cases, you may select the 
device to use DHCP and have the IP address automatically assigned.

1. 

DNS settings are not typically required. The DXM1200-X2 uses a public service to resolve Domain names, but if the 
network connection does not have Internet access, the DNS settings may be required.

2. 
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Settings > Ethernet screen

Configure your Cellular Connection
To use a cellular connection, select Cell as the network connection on the Settings › Cloud Services screen (see "Configure 
the DXM Controller for a Cellular Modem" on page 40). The Cellular screen does not display unless the Network interface is 
set to Cell.

Using a 4G LTE cell module requires a cellular plan; follow the instructions on p/n 205026 to activate a cell modem.

Ethernet and Cellular Push Retries
The DXM1200-X2 can be configured to send register data packets to a webserver. When the Ethernet or cell 
communications path is not operating, the DXM1200-X2 retries the send procedure. The communications retry process is 
outlined below for each configuration.

Regardless of the communications type (Ethernet or cellular), a failed attempt results in the register data packet being saved 
on the local storage device(3). The number of retries will depend upon the network connection type.

When there is bad cellular signal strength or there is no Ethernet connection, the transmission attempts are not counted as 
failed attempts to send data. Only when there is a good network connection and there are 10 failed attempts will the 
controller archive the data on the local storage device. Data archived on the local storage device must be manually retrieved.

Ethernet Push Retries
With an Ethernet-based network connection, the DXM1200-X2 retries a message five times. The five retry attempts 
immediately follow each other. After all attempts are exhausted, the register data packet is saved on the local storage device.

At the next scheduled time, the DXM1200-X2 attempts to send the saved packet as well as the newly created register data 
packet. If it cannot send the new register data packet, the new register data packet is appended to the saved file on the local 
storage device to be sent later. After 10 rounds of retries, the data set is archived on the local storage device under folder 
_sxi. No additional attempts to resend the data are made; the data file must be manually retrieved.

On the Settings › Cellular screen, select your cellular modem from the drop-down list.1. 

◦
◦
◦
◦

Set the APN.
If you are using a Banner 4G LTE-M Verizon Module (ME910C1), set the APN to vzwinternet.
If you are using a Banner 4G LTE AT&T Module (ME910C1), set the APN to iot0119.com.attz.
If you are using a Banner 4G LTE-M/NB-IoT Worldwide Module (ME910G1), set the APN to m2m.tele2.com.
If you are using a third-party SIM card, the APN, APN Username, and Password must be provided by the 
cellular service provider.

2. 

http://info.bannerengineering.com/cs/idcplg?IdcService=GET_FILE&dDocName=205026&RevisionSelectionMethod=Latest&Rendition=web
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Using SSL on Ethernet will have no retries but will save each failed attempt to the local storage device until 10 failed rounds. 
At this time, the register data packet is archived.

Cellular Push Retries
In a cellular-connected system there are no retries. Failed transmissions are saved on the local storage device.

After 10 successive failed attempts, the data is archived in the _sxi folder.

Send attempts with a low signal quality are not counted against the 10-count limit. For example, if the cellular antenna is 
disconnected for period that the DXM controller would have sent 20 messages under normal circumstances, all 20 messages 
would be saved and will be retried when the antenna is reconnected.

If the signal quality was good, but the cellular network was not responding, the DXM1200-X2 archives the register data 
packets after 10 failed attempts.

Event-Action Rule or Log File Push Retries
Event-based pushes caused by Action rules follow the same process when failures occur, based on the network connection. 
The failed Event-based messages are resent with the next cyclical schedule or the next event message that triggers a push 
message.
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PROFINET is a data communications protocol for industrial automation and processes. PROFINET IO defines how 
controllers (IO controllers) and peripheral devices (IO devices) exchange data in real-time. PROFINET® is a registered 
trademark of PROFIBUS Nutzerorganisation e.V. and the standard is maintained by PROFIBUS & PROFINET International 
(PI), an organization headquartered in Karlsruhe, Germany.

Only the DXMR90-4K, DXMR90-X1, DXMR110-8K, DXM700, DXM1000, and DXM1200 Controller models support 
PROFINET IO.

General Station Description Markup Language File
A PROFINET General Station Description (GSD) file is a description of an IO device provided by the device manufacturer in 
an XML format (GSDML.xml).

The GSD file is a standardized way of describing the device information to engineering tools and the IO controller and can 
work across a variety of tools as a standard set of device information.

DXM PROFINET IO Data Model
The PROFINET IO data model is based on the typical, expandable field device that has a backplane with slots. Modules 
have different functionalities.

Modules are plugged into slots. In the PROFINET IO data model, Slot 0, Subslot 1 is reserved for the Device Access Point 
(DAP) or network interface.

Configure the DXM Controller for a PROFINET IO Connection
To use PROFINET, follow these instructions.

The PROFINET data type and data size to/from the DXM Controller is configurable. The PROFINET data is processed from 
the Local Register of the DXM Controller.

Configure the IO-Link ports in the XML according to the modules selected for each port.

Save and Upload the Configuration File
After making any changes to the configuration, you must save the configuration files to your computer, then upload it to the 
device.

Changes to the XML file are not automatically saved. Save your configuration file before exiting the software and before 
sending the XML file to the device to avoid losing data. If you select DXM › Send XML Configuration to DXM before saving 
the configuration file, the software will prompt you to choose between saving the file or continuing without saving the file.

PROFINET®Chapter 9 

Using the DXM Configuration Software, go to the Settings › Ethernet screen.1. 

Select Enable PROFINET.2. 

Save the configuration file and upload it to the DXM Controller (see "Save and Upload the Configuration File" on page 
21).
After PROFINET is enabled, the IP address for the DXM Controller is controlled by the PROFINET host.

3. 

Save the XML configuration file to your hard drive by going to the File › Save As menu.1. 

Go to the DXM › Send XML Configuration to DXM menu.2. 
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Slots and Modules for the DXMR90-X1, DXM700, 
DXM1000, and DXM1200 PROFINET
There are nine slots to accommodate the DXM Controller data.

Slots for input and output values

Values Slots Maximum Data Size

Input values 1–6 1440 bytes

Output values 7–9 1440 bytes

Listing of slots for input and output values

Slot
PLC DXM Local Register Module Size

Module Definition Start End 512

Slot 1 Inputs Integer <- 1 256

Slot 2 Inputs Integer <- 257 512

Slot 3 Inputs Integer <- 513 768

Slot 4 Inputs Float <- 1001 1256

Slot 5 Inputs Float <- 1257 1512

Slot 6 Inputs Float <- 1513 1768

Slot 7 Output Integer -> 5001 5256

Slot 8 Output Integer -> 5257 5512

Slot 9 Output Integer -> 5513 5768

The DXM Local Register association shown uses a Module size of 512 bytes, which equals 256 Local Registers in the DXM. 
Module sizes supported are 64, 128, 256 and 512 bytes. Input Integers are data from the DXM to the PLC. Output integers 
are data from the PLC to the DXM.

Slots 1 through 3

Module Notes

Input Integer 512 Allowed in slots 1-3, Module Identifier= 0x30

Input Integer 256 Allowed in slots 1-3, Module Identifier= 0x31

Input Integer 128 Allowed in slots 1-3, Module Identifier= 0x32

Input Integer 64 Allowed in slots 1-3, Module Identifier= 0x33

Slots 4 through 6

Module Notes

Input Float 512 Allowed in slots 4-6, Module Identifier= 0x34

Continued on page 62

◦

◦
◦

Status indicator bar

If the Application Status indicator is red, close and restart the DXM Configuration Software, unplug and re-plug 
in the cable and reconnect the DXM to the software.
If the Application Status indicator is green, the file upload is complete.
If the Application Status indicator is gray and the green status bar is in motion, the file transfer is in progress.

After the file transfer is complete, the device reboots and begins running the new configuration.
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Continued from page 61

Module Notes

Input Float 256 Allowed in slots 4-6, Module Identifier= 0x35

Input Float 128 Allowed in slots 4-6, Module Identifier= 0x36

Input Float 64 Allowed in slots 4-6, Module Identifier= 0x37

Slots 7 through 9

Module Notes

Output Integer 512 Allowed in slots 7-9, Module Identifier= 0x40

Output Integer 256 Allowed in slots 7-9, Module Identifier= 0x41

Output Integer 128 Allowed in slots 7-9, Module Identifier= 0x42

Output Integer 64 Allowed in slots 7-9, Module Identifier= 0x43

Example configuration for slots and modules

Slot Module Description

Slot 1 Input Integer 512 The two input integer modules have a total of 640 bytes (320 Modbus registers)
The data will come from DXM Local Registers 1 through 320Slot 2 Input Integer 128

Slot 4 Input Float 128
The input Floating register module has a total of 128 byes (64 Modbus registers)
Since it takes two Modbus registers to make a 32-bit floating value, there will be 32 floating point values 
coming from Local Registers 1001-1064

Slot 7 Output Integer 64 The output integer 64 module has a total of 64 bytes (32 Modbus registers).
The data will come from the PLC and be put into DXM Local Registers 5001 through 5032

Configuration Instructions
Install the GSD File
Although these instructions are specific for the Siemens TIA Portal (v14) software, you may use these instructions as a basis 
for installing the GSD file into another controller.

Download the GSD file from www.bannerengineering.com.1. 

Launch the Siemens TIA Portal (v14) software.2. 

Click Open existing project.3. 

Select a project and open it.4. 

After the project is uploaded, click Devices & networks.5. 

http://www.bannerengineering.com
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Devices and networks screen

Click Configure networks.

Configure networks screen

6. 

Click Options and select Manage general station description file (GSD).
The Install general station decription file window opens.

7. 

Click the More options (...) icon to the right of the Source path field and browse to the location the DXM GSD file was 
downloaded to.

8. 

Select the DXM GSD file.9. 

Click Install.10. 
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If the DXM GSD file does not install properly, save the log and contact Banner Engineering Corp.

Change the Device IP Address
Follow these instructions to change the IP address of the DXM device using the Siemens TIA Portal (v14) software. Use 
these instructions as a basis if you are using another controller (PLC).

Hardware catalog

The system installs the DXM GSD file and places it in the Hardware catalog. In the example, the DXM GSD file is 
located under Other field devices › PROFINET IO › Banner Engineering Corp. › Banner.

Launch the Siemens TIA Portal (v14) software.1. 

Click Open existing project.2. 

Select a project and open it.3. 

Click Devices & networks.

Network view

The Network view displays.

4. 

Double-click on the DXM icon to open the Device view screen.5. 

Click on the DXM icon in the graphic area of the Device view screen.
The Module properties window displays and the module can now be configured.

6. 

Click Properties.7. 

Click General.8. 

Select PROFINET Interface › Ethernet addresses.9. 
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Ethernet addresses

Select Set IP address in the project.10. 

Enter the IP address.11. 

Right-click on the device icon and select Online & diagnostics.

Online & diagnostics menu and screen

The Online & diagnostics windows displays.

12. 

Select Assign IP address under Functions.13. 

Click Accessible devices.
The Select device window searches the network for available devices.

14. 

Determine the device to be adjusted via the MAC address and select it.15. 

Click Apply.
The IP address for the device is updated.

16. 

Click Assign IP address to complete the step.17. 
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By default, each DXM shipped from the factory is assigned the IP address 192.168.0.1.

Immediately after the PROFINET protocol is enabled, the DXM has an IP address of 0.0.0.0. We recommend using the TIA 
Portal to give the DXM an IP address so that the address is saved in the unit. When the PLC powers up, this IP address is 
accessible. The PLC can change the IP address if it is configured to do so.

If the PLC assigns the DXM IP address (for example, using the Set IP address in the project option in Siemens TIA Portal), 
the DXM receives the specified address, but only after the program has been loaded into the PLC and is running. If the DXM 
is restarted after it was discovered and configured by the PLC, the DXM retains the IP address that was assigned to it using 
the LCD or software until after the PLC discovers the DXM and assigns it the specified address again. However, if this 
address is different than what is specified in the PLC, the DXM reverts to the address specified in the PLC after the PLC 
becomes active again.

These configuration options conform to the PROFINET standard.

Change the Device Name
Follow these instructions to change the name of the DXM using the Siemens TIA Portal (v14) software. Use these 
instructions as a basis if you are using another controller (PLC).

This step is completed for every device.

Open a project and click on Devices & networks.
The Network view displays.

1. 

Right-click on the DXM icon and select Assign device name.
The Assign PROFINET device name window displays. The software searches for devices of the same type.

2. 

Enter the desired name in the PROFINET device name field. Note that each name can be used only once.3. 

Click Assign name.
The device now has a PROFINET name.

4. 
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For a complete list of all the accessories for the Sure Cross wireless product line, please download the Banner Industrial 
Wireless Accessories list (p/n b_3147091).

Cordsets
BC-M12F5-22-2—5-pin M12, straight, single-ended, 2 m
BC-M12F5-22-10—5-pin M12, straight, single-ended, 10 m
BC-M12F5A-22-2—5-pin M12, right-angle, single-ended, 2 m
BC-M12F5A-22-10—5-pin M12, right-angle, single-ended, 10 m
BCD-M12DM-RJ45-5—RJ45 to 4-pin Male D-Code M12, Straight, 5 m
BCD-M12DM-RJ45-15—RJ45 to 4-pin Male D-Code M12, Straight, 15 
m
BCD-M12DM-RJ45-26—RJ45 to 4-pin Male D-Code M12, Straight, 26 
m

Power Supplies
PSD-24-4—DC Power Supply, Desktop style, 3.9 A, 24 V DC, Class 2, 
4-pin M12 quick disconnect (QD)
PSDINP-24-06—DC power supply, 0.63 Amps, 24 V DC, with DIN Rail 
Mount, Class I Division 2 (Groups A, B, C, D) Rated 
PSDINP-24-13 —DC power supply, 1.3 Amps, 24 V DC, with DIN Rail 
Mount, Class I Division 2 (Groups A, B, C, D) Rated
PSDINP-24-25 — DC power supply, 2.5 Amps, 24 V DC, with DIN Rail 
Mount, Class I Division 2 (Groups A, B, C, D) Rated
PSW-24-1—DC power supply with multi-blade wall plug, 100–240 V AC 
50/60 Hz input, 24 V DC 1 A output, UL Listed Class 2, 4-pin female 
M12 connector

Cellular Communications—Controllers accept Banner LTE-M (CATM1) 
modems only. Cellular modems are ordered separately as accessories 
under the following part numbers:

LTE CAT-M1 AT&T (North America only):SXI-CATM1ATT-001
LTE CAT-M1 Verizon (United States only): SXI-CATM1VZW-001
LTE CAT-M1/NB-IoT Multi-Carrier (Europe only): SXI-
CATM1WW-001

DXM1200-B2 and -X2 AccessoriesChapter 10 

http://info.bannerengineering.com/cs/groups/public/documents/literature/b_3147091.pdf
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http://info.bannerengineering.com/cs/groups/public/documents/literature/180340.pdf
https://www.bannerengineering.com/us/en/products/part.803521.html
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File System and Archive Process
The DXM file system consists of two physical components: the serial EEPROM that stores non-volatile configuration 
information and a local storage device that stores file backup data and user-created files.

EEPROM Files—The serial EEPROM stores basic data that is required to be non-volatile, including network configuration 
data, IP address, MAC address, network masks, firewall settings, and authentication information. The controller XML 
configuration file created by the DXM Configuration Software is stored in EEPROM. The small section of non-volatile local 
registers is also stored in EEPROM.

Local Storage Device Files—The local storage device (micro SD card or embedded flash memory chip) contains most files at 
the root level. The archive directory contains files kept by the system for history backup. Archive files are stored in the 
directory _sxi and are only accessible by removing the local storage device.

Data Log Files
HTTP Push Files
User-created ScriptBasic file
ScriptBasic program file
CmVMon file
_sxi Archive directory

Data Log files
Users may create up to four data log files using the 
DXM Configuration Software. The log files are stored in the 
root directory on the local storage device. When the file size 
limit is reached, the filename is changed to include the date 
and time and the file is moved into the archive directory _sxi. 
Archived log files are deleted based on the Clear Logs 
parameter.

HTTP Push File
If the DXM1200-X2 is configured to send data to a webserver 
or host system, the device creates an HTTP.LOG file on the 
local storage device. The HTTP log is created only if the 
Logging Interval is non-zero and the HTTP enable log is set. 
An entry is placed in the HTTP log file at the Logging Interval 
specified by the user. At the Push Interval time, the HTTP log 
file is sent to the webserver or host system. If the transmission 
is successful, the HTTP log file is time-stamped and placed 
into the archive directory (_sxi). If the transmission fails, the 
file remains in the root directory and subsequent Logging 
Intervals are appended to the file and are sent at the next 
Push Interval. See "Ethernet and Cellular Push Retries" on 
page 58.

User Created ScriptBasic Files
Users may use ScriptBasic to create files on the local storage 
device by using the FILEOUT function. The filenames are 
fixed and up to five files can be created in the root directory.

ScriptBasic Program File
The main ScriptBasic program that runs at boot time is stored 
on the local storage device in the root directory.

CmVMon File
The CmVMon.txt file (Cellular milli-Volt Monitor) is created by 
the system and is used to track power events. Every power-up 
cycle is date/time stamped with the voltage read from the I/O 
board. The value 24487 is equal to 24.487 volts. If the voltage 
drops below 11.2 V, another entry is put in the log file 
indicating the cellular modem will shut down.

CM 2015-09-22 18:52:43 VMon Power entered normal 
range 24487

CM 2015-10-13 20:49:47 VMon Power entered normal 
range 24004

CM 2015-10-16 15:00:20 VMon Power entered normal 
range 24014

CM 2015-10-19 19:12:26 VMon Power entered normal 
range 12845

Product Support and MaintenanceChapter 11 
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_sxi Archive Directory
Only two types of files are moved into the archive directory: 
data log files and HTTP log files. Data log files are date/time 
stamped and placed into the archive directory when the size 

limit is reached. HTTP log files are date/time stamped then 
placed into the archive directory when they are successfully 
sent to the webserver or host system. If the HTTP log files 
were not successfully sent after the retries have been 
exhausted, the files are placed into a root directory called sav.

Updating Your DXM Processor Firmware (Version 2 or Later)
DXMs with processor firmware version 2.0 or later have a built-in boot loader program to update the firmware. Use the 
configuration software version 3 or later, the BannerCDS webserver, or manually write the files on the SD card to update the 
firmware.

The new firmware file loads into the BOOT directory of the SD card on the DXM. The configuration software or 
BannerCDS website handles the reprogramming process automatically. During the programming process, the internal LEDs 
on the processor board indicate the status of the programming.

Update process overview

Reprogramming Step Approximate time required Description

Loading new firmware file (*.HEX) Configuration software: 2 minutes over Ethernet or 
15 minutes over USB
BannerCDS: 2 minutes over Ethernet or 5 minutes 
over Cellular

Send the new firmware image to the DXM. After the new 
image is on the device, the controller resets.
LED3 is red during the loading process.

Verify the contents of the new 
firmware file

1 minute When the DXM finds a file that should be installed, LED4 
(amber) flashes at about a 1 second rate while the contents of 
the file are validated.

New firmware file is valid After validation successfully completes, LED4 is on (amber).

New firmware file is being loaded 2 minutes; do not remove power to the DXM 
during the programming process.

LED3 (red) blinks approximately once per second. LED3 
continues to blink during the application programming 
process.

Finished After programming has completed, the DXM resets and begins 
running the new firmware

The firmware file names follow an 8.3 filename convention. The first 5 characters are the firmware part number in 
hexadecimal; the last 3 characters of the part number are the major/minor version number. For example, if 30FA9052.hex is 
the firmware programming file, 200617 decimal (30FA9 hex) is the firmware part number and 0.5.2 (0502) is the decoded 
version number.

Update the DXM Processor Firmware Using the DXM Configuration Software
To update your processor firmware using the DXM Configuration Software, follow these instructions.

Using the DXM Configuration Software, connect to the DXM via USB(4) or Ethernet.
File loads to the DXM will take about 15 minutes using USB or approximately 2 minutes using Ethernet.

1. 

On the configuration software, go to the Tools › Reprogram › Device Information screen to verify the current firmware 
version and click Get device information.
You must load a different version with the same firmware number for the boot loader to operate. Download firmware 
files from the Banner website.

2. 
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Verify the firmware has been updated and the new file version information displays in the Reprogram screen.

Update Your Processor Firmware Using the BannerCDS Website
To update your processor firmware (version 2.0 or later) using the DXM website, follow these instructions.

To use the website to update the firmware file, first configure the DXM to push data to the website.

Clear the Password on DXM700-Bx, DXM1000-Bx, or 
DXM1200-Bx Models
By default, the DXM Controllers do not require a password to load a configuration file. If a password is defined, the password 
must be entered before uploading a configuration file.

To change the password, you must already know the current password. If you do not know the current password, follow these 
steps to clear the password.

IMPORTANT: Clearing the password erases the current configuration and any program files, log files, or 
history files.

Reprogram screen

Select Verify firmware compatibility before configuring DXM.3. 

Click Select upgrade file4. 

Select the .HEX firmware file provided in the ZIP file you downloaded from www.bannerengineering.com.
The upload process can be seen on the taskbar at the bottom of the software window. Do not do anything to the 
controller until the firmware update process has completed. This is a large file, so it can take up to 15 minutes to 
complete. After the green bar finishes, the DXM will reboot automatically. However, the DXM firmware update process 
is not yet complete. It may take another 5-10 minutes, during which there may not be visible activity. After the clock on 
the DXM's LCD resumes running and you are able to navigate the menu system using the arrows, the firmware 
update process is done.

5. 

Go to Dashboard › Sites and click + to verify the current firmware part number and version on the DXM.

Data collected from the DXM is displayed.

1. 

From the main Dashboard › Sites screen, click on Update.
A popup box appears.

2. 

Set the Communications Type to Push Reply, and set the Update Type to Firmware file.3. 

Choose the appropriate Upload File (*.HEX) and click Queue. Click Close.
At the next scheduled push interval, the DXM retrieves the new firmware file. The new firmware file must be the same 
part number of firmware that is currently in the DXM.

4. 
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DXM1200 Documentation
DXM Wireless Controller Sell Sheet, p/n 194063
DXM1200-B1 Wireless Controller Datasheet, p/n 196719
DXM1200-B2 Wireless Controller Datasheet, p/n 238977
DXM1200-Bx Wireless Controller Instruction Manual, p/n 216539
DXM1200-X2 Wireless Controller Datasheet, p/n 238978
DXM1200-X2 Controller Product Manual, p/n 239172
DXM ScriptBasic Instruction Manual, p/n 191745
DXM Controller Configuration Quick Start, p/n 191247
DXM Configuration Software v4 (p/n b_4496867)
DXM Configuration Software Instruction Manual, p/n 209933
DXM EDS Configuration file for Allen-Bradley PLCs
Activating a Cellular Modem (p/n b_4419353)
Additional technical notes and videos

For more information about the DXM1200 family of products, including technical notes, configuration examples, and 
ScriptBasic program examples, please refer to the Banner website: www.bannerengineering.com

DXM Support Policy
The DXM Wireless Controllers are industrial wireless controllers that facilitate Industrial Internet of Things (IIoT) applications. 
As a communications gateway, it interfaces local serial ports, local I/O ports, and local ISM radio devices to the Internet using 
either a cellular connection or a wired Ethernet network connection. In a continuing effort to provide the best operation for 
the DXM, stay connected with Banner Engineering Corp to hear about the latest updates through the Banner website. Create 
a login today to stay informed of all Banner product releases.

Firmware Updates
The DXM has been designed to be a robust and secure IOT device. To provide the most reliable and secure device possible, 
periodic firmware updates are released to enhance and expand the capabilities of the DXM. Firmware updates and 
description details are found on the Banner website. Customers with critical update requirements will get access to pre-
released firmware from the factory.

Website Information
The Banner website is the main method of disseminating DXM information to customers. The data found on the website 
include:

DXM instruction manuals
Configuration manuals
Firmware downloads
Firmware release notes
Errata data, any known issues with a release of firmware
Possible work-around solutions for known issues
DXM Solutions Guides

Feature Requests
Our customer is our most valuable resource to improve our DXM. If you have suggestions for improvements to the DXM or 
configuration software, please contact Banner Engineering Corp.

Turn on the power to the DXM Controller.1. 

Set DIP switch 4 to the ON position.2. 

Press and hold the processor button until the processor board LED flashes.3. 

Set DIP switch 4 to the OFF position.4. 

Cycle power to the DXM Controller.5. 

Reload the configuration file before resuming normal operation.6. 

http://info.bannerengineering.com/cs/groups/public/documents/literature/194063.pdf
http://info.bannerengineering.com/cs/groups/public/documents/literature/196719.pdf
http://info.bannerengineering.com/cs/groups/public/documents/literature/238977.pdf
http://info.bannerengineering.com/cs/groups/public/documents/literature/216539.pdf
http://info.bannerengineering.com/cs/groups/public/documents/literature/238978.pdf
http://info.bannerengineering.com/cs/groups/public/documents/literature/239172.pdf
http://info.bannerengineering.com/cs/groups/public/documents/literature/191745.pdf
http://info.bannerengineering.com/cs/groups/public/documents/literature/191247.pdf
http://info.bannerengineering.com/cs/groups/public/documents/software/b_4496867.pdf
http://info.bannerengineering.com/cs/groups/public/documents/literature/209933.pdf
http://info.bannerengineering.com/cs/groups/public/documents/product_data_files/b_4205242.pdf
http://info.bannerengineering.com/cs/groups/public/documents/literature/b_4419353.pdf
http://www.bannerengineering.com
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Potential DXM Issues
Potential issues with the DXM are collected from Banner's support engineers to provide solutions. Users can get help from 
the website documentation or by calling Banner Engineering for support help. Solutions are as simple as configuration 
adjustments, work-around configuration solutions, or potential new firmware updates.

DXM Security
The DXM was designed to collect local wireless sensor data, local sensor data, provide simple control, and send the data to 
the cloud.

The DXM does not run a Linux or Windows-based operating system but an embedded real-time operating system (RTOS) 
environment. As a proprietary operating system, the security aspects are easier to manage and minimize.

Security updates are released through the Banner Engineering Corp website (www.bannerengineering.com) and New 
Product Release Announcements (NPRA).

Contact Us
Banner Engineering Corp. | 9714 Tenth Avenue North | Plymouth, MN 55441, USA | Phone: + 1 888 373 6767

For worldwide locations and local representatives, visit www.bannerengineering.com.

FCC and ISED Certification for 900 MHz
This equipment contains transmitter module RM1809 or SX7023EXT.

Radio Module RM1809 Radio Module SX7023EXT

FCC ID: UE3RM1809 FCC ID: UE3SX7023EXT

IC: 7044A-RM1809 IC: 7044A-SX7023EXT

HVIN: RM1809 HVIN: 223150

FCC Notices
IMPORTANT: The transmitter modules RM1809 and SX7023EXT have been certified by the FCC / ISED for use with other 
products without any further certification (as per FCC section 2.1091). Changes or modifications not expressly approved by 
the manufacturer could void the user’s authority to operate the equipment.

IMPORTANT: The transmitter modules RM1809 and SX7023EXT have been certified for fixed base station and mobile 
applications. If modules will be used for portable applications, the device must undergo SAR testing.

IMPORTANT: If integrated into another product, the FCC ID label must be visible through a window on the final device or it 
must be visible when an access panel, door, or cover is easily removed. If not, a second label must be placed on the outside 
of the final device that contains the following text:

Transmitter Module [RM1809 or SX7023EXT]
Contains FCC ID: [UE3RM1809 or UE3SX7023EXT]
Contains IC: [7044A-RM1809 or 7044A-SX7023EXT]
HVIN: [RM1809 or 223150]

This device complies with Part 15 of the FCC Rules. This equipment generates, uses, and can radiate radio frequency 
energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio 
communications. Operation is subject to the following two conditions: 1) This device may not cause harmful interference; and 
2) This device must accept any interference received, including interference that may cause undesired operation.

Antenna WARNING: This device has been tested with Reverse Polarity SMA connectors with the antennas listed in "Certified 
Antennas for 900 MHz" on page 73. When integrated into OEM products, fixed antennas require installation preventing end-
users from replacing them with non-approved antennas. Antennas not listed in the tables must be tested to comply with FCC 
Section 15.203 (unique antenna connectors), FCC Section 15.247 (emissions), and ISED RSS-Gen Section 6.8.

FCC and ISED Approved Antennas
WARNING: Antenna(s) used for this transmitter must be installed to provide a separation distance of at least 20 cm from all 
persons.

AVERTISSEMENT : Les antennes utilisées pour cet émetteur doivent être installées de manière à assurer une distance de 
séparation d'au moins 20 cm de toutes les personnes.

http://www.bannerengineering.com
http://www.bannerengineering.com/us/en/company/press-releases.html#all
http://www.bannerengineering.com
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NOTICE: This equipment is approved only for mobile and base station transmitting devices. The antenna(s) used for this 
transmitter must not transmit simultaneously with any other antenna or transmitter, except in accordance with FCC multi-
transmitter product procedures.

The radio transmitter modules RM1809 and SX7023EXT have been approved by FCC and ISED Canada to operate with the 
antenna types listed below, with the maximum permissible gain indicated. Antenna types not included in this list that have a 
gain greater than the maximum gain indicated for any type listed are strictly prohibited for use with this device.

Certified Antennas for 900 MHz

Model Number Antenna Type 900 MHz Radio Module Maximum Gain Impedance Minimum Required 
Cable/Connector Loss

- Integral Antenna RM1809 Unity gain 0

BWA-9O1-x Omni, 1/4 wave dipole RM1809 ≤2 dBi 50 Ω 0

BWA-9O2-C Omni, 1/2 wave dipole, Swivel RM1809 or SX7023EXT ≤2 dBi 50 Ω 0

BWA-9O6-A Omni Wideband, Fiberglass 
Radome RM1809 ≤8.2 dBi 50 Ω 2.2 dB

BWA-9O5-B Omni Base Whip RM1809 ≤7.2 dBi 50 Ω 1.2 dB

BWA-9Y10-A Yagi RM1809 ≤10 dBi 50 Ω 4 dB

BWA-9O5-C Coaxial sleeve SX7023EXT ≤5 dBi 50 Ω 0

BWA-9O6-AS Omni SX7023EXT ≤6 dBi 50 Ω 0

FCC and ISED Certification for 2.4 GHz
This equipment contains transmitter module DX80-2400 or SX243.

Radio Module DX80-2400 Radio Module SX243

FCC ID: UE300DX80-2400 FCC ID: UE3SX243

IC: 7044A-DX8024 IC: 7044A-SX243

HVIN: DX80G2 / DX80N2 HVIN: SX243

FCC Notices
IMPORTANT: The transmitter modules DX80-2400 and SX243 have been certified by the FCC / ISED for use with other 
products without any further certification (as per FCC section 2.1091). Changes or modifications not expressly approved by 
the manufacturer could void the user’s authority to operate the equipment.

IMPORTANT: The transmitter modules DX80-2400 and SX243 have been certified for fixed base station and mobile 
applications. If modules will be used for portable applications, the device must undergo SAR testing.

IMPORTANT: If integrated into another product, the FCC ID/IC label must be visible through a window on the final device or it 
must be visible when an access panel, door, or cover is easily removed. If not, a second label must be placed on the outside 
of the final device that contains the following text:

Transmitter Module [DX80-2400 or SX243]
Contains FCC ID: [UE300DX80-2400 or UE3SX243]
Contains IC: [7044A-DX8024 or 7044A-SX243]
HVIN: [DX80G2, DX80N2 or SX243]

This device complies with Part 15 of the FCC Rules. This equipment generates, uses, and can radiate radio frequency 
energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio 
communications. Operation is subject to the following two conditions: 1) This device may not cause harmful interference; and 
2) This device must accept any interference received, including interference that may cause undesired operation.

Antenna Warning: This device has been tested with Reverse Polarity SMA connectors with the antennas listed in "Certified 
Antennas for 2.4 GHz" on page 74. When integrated into OEM products, fixed antennas require installation preventing end-
users from replacing them with non-approved antennas. Antennas not listed in the tables must be tested to comply with FCC 
Section 15.203 (unique antenna connectors), FCC Section 15.247 (emissions), and ISED RSS-Gen Section 6.8.
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FCC and ISED Approved Antennas
AVERTISSEMENT : Les antennes utilisées pour cet émetteur doivent être installées de manière à assurer une distance de 
séparation d'au moins 20 cm de toutes les personnes.

NOTICE: This equipment is approved only for mobile and base station transmitting devices. The antenna(s) used for this 
transmitter must not transmit simultaneously with any other antenna or transmitter, except in accordance with FCC multi-
transmitter product procedures.

The radio transmitter modules DX80-2400 and SX243 have been approved by FCC and ISED Canada to operate with the 
antenna types listed below, with the maximum permissible gain indicated. Antenna types not included in this list that have a 
gain greater than the maximum gain indicated for any type listed are strictly prohibited for use with this device.

Certified Antennas for 2.4 GHz

Model Antenna Type 2.4 GHz Radio Module Maximum Gain Impedance

Integral antenna DX80-2400 or SX243 Unity gain

BWA-2O2-C Omni, 1/2 wave dipole, Swivel DX80-2400 or SX243 ≤ 2 dBi 50 Ω

BWA-2O2-D Omni, Dome, Box Mount DX80-2400 or SX243 ≤ 2 dBi 50 Ω

BWA-2O2-E Omni, 1/4 wave dipole, Swivel DX80-2400 or SX243 ≤ 2 dBi 50 Ω

BWA-2O5-C Omni, Collinear, Swivel DX80-2400 ≤ 5 dBi 50 Ω

BWA-2O5-MA Omni, full-wave dipole, NMO DX80-2400 ≤ 4.5 dBi 50 Ω

BWA-2O6-A Omni, Dome, Box Mount DX80-2400 ≤ 6 dBi 50 Ω

BWA-2O7-C Omni, Coaxial Sleeve, Swivel DX80-2400 ≤ 7 dBi 50 Ω

Mexican Importer
Banner Engineering de Mèxico, S. de R.L. de C.V. | David Alfaro Siqueiros 103 Piso 2 Valle oriente | San Pedro Garza Garcia Nuevo Leòn, C. P. 66269

81 8363.2714

ANATEL
Este equipamento não tem direito à proteção contra interferência prejudicial e não pode causar interferência em sistemas 
devidamente autorizados.  Para maiores informações, consulte o site da ANATEL www.gov.br/anatel/pt-br/ 

Warnings
WARNING:

Do not use this device for personnel protection 
Using this device for personnel protection could result in serious injury or death.
This device does not include the self-checking redundant circuitry necessary to allow its use in personnel safety applications. A 
device failure or malfunction can cause either an energized (on) or de-energized (off) output condition.

IMPORTANT: Please download the complete DXM1200-X2 Wireless Controller technical documentation, available in multiple 
languages, from www.bannerengineering.com for details on the proper use, applications, Warnings, and installation instructions of this 
device. 

IMPORTANT: Por favor descargue desde www.bannerengineering.com toda la documentación técnica de los DXM1200-X2 Wireless 
Controller, disponibles en múltiples idiomas, para detalles del uso adecuado, aplicaciones, advertencias, y las instrucciones de 
instalación de estos dispositivos. 

http://www.gov.br/anatel/pt-br/
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IMPORTANT: Veuillez télécharger la documentation technique complète des DXM1200-X2 Wireless Controller sur notre site 
www.bannerengineering.com pour les détails sur leur utilisation correcte, les applications, les notes de sécurité et les instructions de 
montage. 

Install and properly ground a qualified surge suppressor when installing a remote antenna system. Remote antenna configurations installed without surge 
suppressors invalidate the manufacturer's warranty. Keep the ground wire as short as possible and make all ground connections to a single-point ground system 
to ensure no ground loops are created. No surge suppressor can absorb all lightning strikes; do not touch the Sure Cross® device or any equipment connected 
to the Sure Cross® device during a thunderstorm. 

Exporting Sure Cross® Radios. It is our intent to fully comply with all national and regional regulations regarding radio frequency emissions. Customers who want 
to re-export this product to a country other than that to which it was sold must ensure the device is approved in the destination country. The Sure Cross wireless 
products were certified for use in these countries using the antenna that ships with the product. When using other antennas, verify you are not exceeding the 
transmit power levels allowed by local governing agencies. This device has been designed to operate with the antennas listed on Banner Engineering’s website 
and having a maximum gain of 9 dBm. Antennas not included in this list or having a gain greater than 9 dBm are strictly prohibited for use with this device. The 
required antenna impedance is 50 ohms. To reduce potential radio interference to other users, the antenna type and its gain should be so chosen such that the 
equivalent isotropically radiated power (EIRP) is not more than that permitted for successful communication. Consult with Banner Engineering Corp. if the 
destination country is not on this list.

IMPORTANT:
Never operate a radio without connecting an antenna
Operating radios without an antenna connected will damage the radio circuitry.
To avoid damaging the radio circuitry, never apply power to a Sure Cross® Performance or Sure Cross® MultiHop radio 
without an antenna connected.

IMPORTANT:
Electrostatic discharge (ESD) sensitive device
ESD can damage the device. Damage from inappropriate handling is not covered by warranty.
Use proper handling procedures to prevent ESD damage. Proper handling procedures include leaving devices in their anti-
static packaging until ready for use; wearing anti-static wrist straps; and assembling units on a grounded, static-dissipative 
surface.

Banner Engineering Corp Limited Warranty
Banner Engineering Corp. warrants its products to be free from defects in material and workmanship for one year following the date of shipment. Banner 
Engineering Corp. will repair or replace, free of charge, any product of its manufacture which, at the time it is returned to the factory, is found to have been 
defective during the warranty period. This warranty does not cover damage or liability for misuse, abuse, or the improper application or installation of the Banner 
product.

THIS LIMITED WARRANTY IS EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES WHETHER EXPRESS OR IMPLIED (INCLUDING, WITHOUT 
LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE), AND WHETHER ARISING UNDER COURSE OF 
PERFORMANCE, COURSE OF DEALING OR TRADE USAGE.

This Warranty is exclusive and limited to repair or, at the discretion of Banner Engineering Corp., replacement. IN NO EVENT SHALL BANNER ENGINEERING 
CORP. BE LIABLE TO BUYER OR ANY OTHER PERSON OR ENTITY FOR ANY EXTRA COSTS, EXPENSES, LOSSES, LOSS OF PROFITS, OR ANY 
INCIDENTAL, CONSEQUENTIAL OR SPECIAL DAMAGES RESULTING FROM ANY PRODUCT DEFECT OR FROM THE USE OR INABILITY TO USE THE 
PRODUCT, WHETHER ARISING IN CONTRACT OR WARRANTY, STATUTE, TORT, STRICT LIABILITY, NEGLIGENCE, OR OTHERWISE.

Banner Engineering Corp. reserves the right to change, modify or improve the design of the product without assuming any obligations or liabilities relating to any 
product previously manufactured by Banner Engineering Corp. Any misuse, abuse, or improper application or installation of this product or use of the product for 
personal protection applications when the product is identified as not intended for such purposes will void the product warranty. Any modifications to this product 
without prior express approval by Banner Engineering Corp will void the product warranties. All specifications published in this document are subject to change; 
Banner reserves the right to modify product specifications or update documentation at any time. Specifications and product information in English supersede that 
which is provided in any other language. For the most recent version of any documentation, refer to: www.bannerengineering.com.

For patent information, see www.bannerengineering.com/patents.

http://www.bannerengineering.com
http://www.bannerengineering.com/patents
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